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About CallPilot

This chapter introduces CallPilot, the powerful multimedia messaging syste
from Nortel Networks. CallPilot offers a single solution for managing many 
types of information, including voice mail, fax-mail, e-mail, telephone calls, 
conferencing, calendars, directories, and call logs.

CallPilot enables you to get all the information you need from one source, 
whether through display-based telephone sets, your wireless set, your Win
desktop computer, a speech recognition interface, or another personal 
communications device. 

In this chapter 
About this guide 13

Finding your way around CallPilot 35
NMS Implementation and Administration Guide 11
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Overview

Introduction
The NMS Implementation and Administration Guide provides the information 
and procedures that are necessary to implement NMS.

Assumptions
This guide assumes that the Meridian Application Server has been correctl
installed and is operational. If the application has not been installed, then in
it before proceeding. For installation instructions, refer to the hardware 
installation guide appropriate to your server type.

If the server has been installed but is not operational, refer to the Maintenance 
and Diagnostics Guide for information on troubleshooting your system.
14 CallPilot
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Skills you need

Introduction
You need certain skills and knowledge to use this guide effectively.

Nortel Networks product knowledge
Knowledge of, or experience with, the following Nortel Networks products w
assist you:

■ Meridian 1

■ Meridian Mail

PC experience or knowledge
Knowledge of, or experience with, the following PC products will be of 
assistance. This guide does not document the following functionality:

■ Microsoft Windows NT

■ Microsoft Windows 95

Other experience or knowledge
Other types of experience or knowledge that may be of use include the 
following:

■ network management

■ client-server systems

■ flowcharting
NMS Implementation and Administration Guide 15
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Related information products

Introduction
Following is a list of all CallPilot technical documents. The CD-ROM that yo
receive with your system contains these guides, enabling you to search the 
suite of documentation online. If you prefer, you can print out entire guides,
parts of a guide. 

You order copies of these documents using the NTP numbers or P0 numbe
provided. 

Planning and migration
These guides are used before CallPilot is installed to help you plan your sy
and, if you have a Meridian Mail system, migrate to CallPilot. 

Document Title NTP number

Planning and Engineering Guide 555-7101-101

Meridian Mail to CallPilot Migration Guide 555-7101-801
16 CallPilot
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Installation guides
These guides describe how to install server hardware and CallPilot softwar

Administration and feature guides
These guides describe how to configure CallPilot, administer and maintain 
and use its features. 

Document Title

NTP number
or
P0 number

Meridian Application Server 200i Installation Guide P0884895

Meridian Application Server 702t Installation and 
Maintenance Guide

P0884909

Meridian Application Server 1001rp Installation and 
Maintenance Guide

P0886776

Software Installation Guide 555-7101-200

Document Title NTP number

Basic Administration Guide 555-7101-300

Advanced Administration Guide - 
volume 1

555-7101-301

Advanced Administration Guide - 
volume 2

555-7101-301

Reporter Guide 555-7101-310

Application Builder Guide 555-7101-325
NMS Implementation and Administration Guide 17



About CallPilot  Standard 1.00

king 

 help 

t users 
Networking guides
These guides describe how to plan, install, set up, and troubleshoot networ
services. 

Maintenance and troubleshooting guides
These guides describe how to maintain your system once it is in service and
you troubleshoot operational problems.  

End user guides
These guides are intended for end users of CallPilot, such as telephone se
and desktop messaging users. 

Document Title NTP number

Networking Planning Guide 555-7101-100

NMS Implementation and Administration Guide 555-7101-302

AMIS Networking Implementation and Administration 
Guide

555-7101-303

Enterprise Networking Implementation and 
Administration Guide

555-7101-304

Integrated AMIS Networking Implementation and 
Administration Guide

555-7101-305

VPIM Networking Implementation and Administration 
Guide

555-7101-306

Document Title NTP number

Maintenance and Diagnostics Guide 555-7101-500

Support Tools Guide 555-7101-800

Document Title P0 number

Speech Activated Messaging User Guide P0886127
18 CallPilot
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CD ROM
The CD-ROM contains all the listed documents, except the end user guides

Multimedia Messaging Quick Reference Card P0886128

Multimedia Messaging User Guide P0886140

Desktop Messaging for Microsoft Exchange Guide P0886141

Desktop Messaging for Lotus Notes Guide P0886142

Internet Messaging Guide P0886143

Document Title Order number

CallPilot Technical Documentation CD NTRG19AA

A0742811

Document Title P0 number
NMS Implementation and Administration Guide 19
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Using the online reference guides

Introduction
The online reference guides contain the same procedures and context-sen
information that you find in the online Help. However, the guides contain 
additional information not included in the online Help. These guides have 
overview sections that describe concepts and features and provide other 
CallPilot information.

To print an online guide, see Printing an online guide on page 28.

The online guides
The following reference guides are available online.

■ Overview Guide

■ Advanced Administration Guide

■ Application Builder Guide

■ Reporter Guide

■ Networking guides

● Networking Planning Guide

● AMIS Networking Implementation and Administration Guide

● Integrated AMIS Networking Implementation and Administration Gu

● Enterprise Networking Implementation and Administration Guide

● VPIM Networking Implementation and Administration Guide

● NMS Implementation and Administration Guide
20 CallPilot
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To access the online guides

1 On the Help menu, click Reference Guides.

Attention:  If you see the following error message, Adobe Acrobat was not 
installed during the MAS software installation. Refer to the Software 
Installation Guide for the Acrobat Installation procedure.
NMS Implementation and Administration Guide 21
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2 Click the document you want to open.

Result: The front cover is displayed. Select a chapter from the front cover 
or from the bookmarks displayed in the left frame.

Navigating the online guides
There are several ways to navigate through the guides and to find specific to 
22 CallPilot
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Bookmarks
Bookmarks are displayed on the left-hand side of each document. To go to
specific part of the document, such as a chapter or section, click the bookm
 

NMS Implementation and Administration Guide 23
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Using hypertext links
Once you find the chapter or section you are interested in, use hypertext lin
navigate within the chapter and document.

Links appear as blue underlined text.
 

24 CallPilot
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When you click a link, the selected topic is displayed.
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Using the document button bar
The online guides have a button bar at the top of each page to help you ge
around quickly. 

On each page you can use the following buttons:  

Using Acrobat Reader commands
Adobe Acrobat Reader also has features to help you work through the docum
You can learn more about Reader by accessing its online guide from the Ac
Reader Help menu.

Here are some of the more common commands:

Button Description

home Goes to the cover page of the current guide.

help Provides tips on how to use the online guides.

contents Goes to the table of contents for the current guide.

index Goes to the index for the current guide.

back Goes to the previous page in the guide.

next Goes to the next page in the guide.

 Function Description

. Goes back to the last view and forward to the next view

. Goes to the previous page and to the next page in the 
document.
26 CallPilot
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Searching for information
You can use the Acrobat Search tool to find specific information. This tool 
enables you to find all instances of a word or phrase. You can search eithe
current guide or all the online guides.  

. Goes to the first page of the document and to the last pa
of the document.

Search function Description

. 

Searches the current document for all instances of the 
word or phrase you type. Goes to the first page that has
least one instance of the word or phrase, and highlights
your choice.

. 

Searches all the online guides for the word or phrase yo
type. Displays a list of the guides containing the search
word or phrase. The guide you select opens to the first 
page that has at least one instance of the word or phras
and highlights your choice.

. 

Goes to the next instance of the word or phrase.

. 

Goes to the previous instance of the word or phrase.

 Function Description
NMS Implementation and Administration Guide 27
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Printing an online guide
For best results when you print an online guide, use a Postscript-compatibl
printer capable of 600 dpi output. If a Postscript printer is not available, use
Adobe Acrobat 3.0 (not Acrobat 3.01). Acrobat 3.0 is installed by default wi
the CallPilot 1.0 Administration client software. It is also available from http
www.adobe.com.

To set print properties for an online guide

1 In Acrobat Reader, open the file for the online guide.

2 From the File menu, select Print Setup...

3 In the Print Setup dialog box, select Properties.

4 Select the Graphics tab.

5 Select Resolution, and then select 600 dpi.

6 Click OK until you exit from all the dialog boxes.

Note: Your screens should print out legibly, even on a non-Postscript 
printer.

To print an online guide

1 From the File menu, select Print.

2 Indicate the page range.

3 Click OK.
28 CallPilot
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Contacting technical support

Introduction
Contact your distributor’s technical support organization to get help with 
troubleshooting your system.

Before contacting Technical Support, ensure that you have the necessary 
information on hand.

Information about your server
Technical Support may ask for the following information, which is displayed
the Server Settings window: 

■ server version number

■ release number

■ serial number (if you have this number available)

Getting there  Nortel SMI > Meridian Application Server > System 
Administration

To view server settings

1 Double-click System Configuration.

2 Double-click Server Settings.
NMS Implementation and Administration Guide 29



About CallPilot  Standard 1.00

t part, 

nd 

e 
Identifying Field Replacement Units (FRUs)
If you have diagnosed a hardware problem and need to order a replacemen
you must be able to identify the part.

For more information about running diagnostics on hardware components a
identifying field replacement units, see the Maintenance and Diagnostics Guide.

Contacting Nortel Networks
If you have comments or suggestions for improving CallPilot and its 
documentation, Nortel Networks would like to hear from you. Please see th
following address:

http://www.nortelnetworks.com/callpilot_feedback
30 CallPilot
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How this guide is organized

Introduction
The NMS Implementation and Administration Guide is organized in the 
sequence of tasks required to successfully implement NMS for CallPilot. Sta
the beginning of the guide and work your way through it until all required ta
are completed.

Contents
This guide contains the following chapters.

Chapter title Description

Chapter 1, About CallPilot This chapter describes how to work with the
CallPilot interface and how to use this guide

Chapter 2, Getting started This chapter provides an overview of NMS.

This chapter describes the features support
by NMS and how NMS works.

This chapter also provides a high-level 
overview of the tasks that are performed 
during implementation.

Chapter 3, Gathering information This chapter explains how to gather the 
information required to implement NMS.

Chapter 4, Configuring the switches This chapter explains how to configure the 
switches for NMS.

Chapter 5, Configuring CallPilot for NMSThis chapter describes how to configure 
CallPilot for NMS. This chapter describes 
how to configure the local site and all satellite
switch locations.

This chapter describes every box that must b
completed and provides detailed procedures
NMS Implementation and Administration Guide 31
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Chapter 6, Testing and backing up NMSThis chapter describes how to test the 
implementation of NMS to ensure that it is 
properly configured. This chapter also 
describes how to perform a backup of the 
system.

Chapter 7, Maintaining NMS This chapter explains how to perform both 
regularly scheduled maintenance tasks and
as-required maintenance tasks.

Chapter 8, Troubleshooting NMS This chapter provides information to identify
and solve problems with NMS.

Chapter title Description
32 CallPilot



November 1998 About CallPilot 

cute 
 

here 

you 
 after 

n the 
 

Conventions

Introduction
This guide uses the following conventions.

How commands are documented in procedures
As with many Windows applications, there are several different ways to exe
a command. For example, to copy text, you can choose any of the following
methods:

■ Choose Copy from the Edit menu.

■ Click the Copy button on the toolbar.

■ Type the keyboard shortcut Control + C.

The procedures in this guide document only the first method, choosing a 
command from a menu.

Navigation information in procedures: Getting there
Procedures in this guide are preceded by a Getting there statement. This 
statement summarizes the steps you take to navigate to the window or tab w
the procedure is carried out.

All Getting there statements start at the Nortel SMI window. This assumes 
have logged on and selected the appropriate system. Each item mentioned
that represents an icon, window, or tab that makes up the path to the final 
destination. 

Example
To define special mailboxes such as the broadcast mailbox, you must be o
Mailboxes tab. The Getting there statement for this procedure is as follows:

Getting there  Nortel SMI > Meridian Application Server > CallPilot > Messaging 
Administration
NMS Implementation and Administration Guide 33
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After you double-click Messaging Administration, the property sheet display
You then click the Mailboxes tab.
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Finding your way around CallPilot
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Connecting to CallPilot

Introduction
To perform administrative tasks, or to build or work with CallPilot application
you must first connect to the Meridian Application Server (the MAS server).
The MAT Navigator and the System Management Interface (SMI) work 
together to give you access to your system and sites.

Selecting a system—the MAT Navigator
The first step in logging in is to launch the MAT Navigator, which has its ow
password. The MAT Navigator connects your administration client to the M
server. It displays all your sites and systems and enables you to select one
work on.
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Selecting a program—the System Management Interface (SMI)
When you select a system from the MAT Navigator, you are prompted for a
second password. At this point, the SMI window for the selected system or 
displays. 
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The SMI gives you quick and easy access to your system or sites. The SMI
a navigation tree to display the system’s hierarchy. In the tree, icons repres
the folders and programs. Double-click a folder icon to view its contents. 
Folders can contain programs and other folders. Double-click a program ico
run the associated program. 

Selecting an object—list views
When you launch certain programs, the first thing you see is a list view. The
view displays all the objects of a certain type (such as mailbox classes) tha
currently defined in the system. The list view includes predefined objects as
as those defined by an administrator. From the list view window, you can se
a specific object to work on.
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Viewing and changing properties
Select an object and display its properties by 

■ double-clicking it or 

■ single-clicking it and selecting Properties from the File menu

■ right-clicking it and selecting Properties from the popup menu

Entering data and choosing options—property sheets
A property sheet is displayed when you view an object selected from a list v
Certain programs, such as Messaging Administration, display a property sh
immediately after launching. Property sheets have one or more tabs. Each 
has fields, referred to as boxes, in which you can type data or from which y
can select options. 
NMS Implementation and Administration Guide 39



About CallPilot  Standard 1.00
Most CallPilot property sheets look like the following:
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Some property sheets are divided into two panes. When a box is checked i
left pane, the selected capabilities are enabled and you can access the ass
tabs. Select a tab by clicking its name in the left pane or by clicking the tab in
right pane. These property sheets look like this:
 

Mandatory boxes
If the name of a box is underlined, the box is mandatory, and you must fill it
You cannot save if any mandatory boxes are empty.
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Common buttons
The following buttons appear on most property sheets: 

Using the toolbar buttons
For easier access, some of the more common tasks, such as Print and Sav
represented as buttons on the toolbar. 

The following buttons are used throughout CallPilot. Buttons or icons specifi
certain CallPilot functions, such as backups and archives, are documented 
relevant chapters.

Button Description

Save Saves all changes made on any of the tabs in a property s
and closes the property sheet. Therefore, save only when y
have made the necessary changes on all tabs.

Cancel Closes the property sheet without saving any changes.

Print Prints the contents of all tabs in the property sheet.

Help Displays Help for the current tab. From this overview Help 
topic, you can access other Help topics, the index, and the
search function.

Toolbar button Description

. 

Saves any changes you have made and then transfers 
the application’s data to the server.

. 

Opens the Print dialog box and prints the active file or th
objects you specify.

. 

Deletes the object you select.
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Displays the properties of the object you select.

. 

Displays the Help topics window.

. 

Explains the next menu item or screen object you click. 
a window, there is an arrow. On tabs or in dialog boxes
there is no arrow.

. 

Opens the New dialog box, where you identify the 
properties of the object you are creating. The button loo
different in different applications.

. 

Displays the Open dialog box, where you select an obje
to open. The button is different in different applications.

. 

Reloads the current page and displays the changes you
have made.

. 

Enables you to select how the system displays icons.

Toolbar button Description
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Multi-administrator access

Introduction
You can create multiple administrator accounts to make administering CallP
easier and more efficient. Multiple accounts enable administration 
responsibilities to be distributed among a number of people. Therefore, cer
administrators can specialize in certain tasks, such as maintaining users, 
performing backups, analyzing reports, or creating multimedia services. 

Access classes
For security reasons, administrators should be given access only to those pa
the system that relate to their role. For example, an administrator who is 
responsible only for creating multimedia services should have access only 
Application Builder and the Service Directory Number Table. 

Each administrator account is assigned an access class. An access class i
of the parts of the system and the level of access allowed. The access leve
as follows:

■ create/delete (enables an administrator to delete objects such as users
services)

■ edit

■ view

■ none

For example, an administrator may be able to create or delete objects in 
Application Builder but only view User Templates.

Simultaneous access
Multiple administrators can log in to CallPilot at the same time without 
overwriting other work.

If you are the first to log in to a particular resource, such as a specific mailb
class or user profile, and another administrator tries to access the same res
a dialog box appears to inform you of the other administrator. At this point, 
can do one of the following:
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■ Keep editing.

■ Save your changes, and release the resource to the other administrato

■ Cancel your changes, and release the resource to the other administra

If you do not respond to this prompt within two minutes—because you are a
from the terminal, for example—the system releases the resource so that o
can access it. If this happens, all your unsaved changes are lost.

An administrator who accesses a resource that is currently being edited se
read-only view of the property sheet in which all boxes are dimmed. This 
indicates that the resource is currently locked. The administrator is not notif
when the resource is released, but must try to access the property sheet ag
see whether its status has changed. 

If a user tries to log on to a mailbox while an administrator is changing the 
profile, the user is unable to log on and receives a message that says the m
is in use.

Refreshing screens
Because multiple administrators can access the same database at the sam
a Refresh command is available from the View menu to ensure that the view
are seeing is the most up-to-date. 

For example, if you are viewing a list of users when another administrator 
deletes a user, the only way to see the change is to refresh the screen. You
should, therefore, refresh the screen regularly.
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Error handling in property sheets

Introduction
If you make certain types of errors while entering data, you are not able to s
your changes until you correct the errors. For example, if you leave a mand
box empty, you receive a message prompting you to fix it. 

Note: These errors do not show up in the Event Browser or Alarm Monitor 
because the errors relate only to data entry and are not operational problem

How error handling works
There are two types of error messages.

Type 1
If you get this type of error message, click OK, and then fix the problem 
described in the message before you try to save again.
46 CallPilot



November 1998 About CallPilot 

 

Type 2
If you get this type of error message, click OK to see a list of errors.

Double-click an error from the list. Your cursor is automatically placed in the
box where the error was made so that you can correct it. 
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For example, if you double-click the second error, the Remote notification ta
displayed, with the cursor in the Target number box. 
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Using the online Help

Introduction
While administering or maintaining CallPilot, you may have questions about
purpose of certain boxes and buttons, or need more information about 
completing certain tasks. 

Online Help provides brief answers to the questions “What’s this?” and “Ho
do I...?”
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Context-sensitive Help
If you need to know the purpose of a particular box or button, use context-
sensitive Help.

To access context-sensitive Help

1 Click the  icon in a window or the  icon on a tab or in a dialog 
box.

2 Point to the box or button for which you want more information, and click.

Result: A pop-up description of the selected object is displayed.
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Procedures
If you need to know how to do something, you can access procedures to le
you through a task. 

High-level tasks
In some cases, high-level tasks take you through longer procedures. These
also provide you with navigation to the step-by-step procedures they includ
NMS Implementation and Administration Guide 51
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For example, setting up Delivery to Telephone requires several procedures
high-level task summarizes these procedures. You click the gray buttons w
the task to open the step-by-step procedures. The high-level task remains o
your screen so that you can continue to use it to move through the procedu
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Overviews
Overview topics provide brief descriptions of tabs, features, and the tasks 
carried out from the tabs. However, the online guides contain more detailed
feature descriptions.

To access overview topics

Click the Help button on a tab.

To find information in Help
You can look up procedures and overview topics in the following ways: 

1 From the Help menu, select Help Topics.

Note: You can also press F1 on the keyboard.

2 Go to one of the following tabs: 

■ To see the table of contents of all the Help topics, select the Contents 
tab.

■ To look up a subject alphabetically, select the Index tab.

■ To do a full-text search to find topics that contain the words you enter, 
select the Find tab.
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Getting started

This chapter introduces Network Message Service (NMS) and provides a b
overview of the implementation process.

This chapter also covers some basic networking concepts and terminology
are useful for understanding NMS.

In this chapter 
About Network Message Service 57

Dialing plans and NMS 75

Implementing NMS 83
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About Network Message Service

In this section
Overview 58

NMS benefits 61

Links and protocols 63

NMS and users 64

NMS access mechanisms 65

NMS features and considerations 67

Feature interaction 71
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Overview

Introduction
Network Message Service (NMS) is a CallPilot feature that enables one 
Meridian Application Server to provide messaging services to users in a netw
of compliant switches.

NMS network
The collection of switch locations, connections, and the messaging server i
collectively known as an NMS network.

The following diagram illustrates an NMS network consisting of the Meridia
Application Server, a prime switch location, and two satellite switch location
Only the prime switch location is directly attached to the server.

G100947.eps

Satellite switch

Prime switch

MAS server Satellite switch
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NMS site
An NMS network is often a site within a more complex messaging network.

When an NMS network is part of a messaging network, it is called an NMS 
A messaging network can have many NMS sites.

In the following diagram, the messaging network consists of six sites. Site 5
Site 6 are NMS sites. CallPilot networking solutions are implemented on all
sites.

Private messaging network
A private messaging network is made up of two or more sites that are conne
by communication channels. These channels are maintained and restricted 
organization’s private use.

NMS networks are private
An NMS network is a type of private messaging network. An NMS network 
set up and maintained by an organization for private use.

An NMS site is part of a private messaging network.

G101139.ep

 Site 1  Site 2

 Site 3  Site 4

 Site 5  Site 6
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Off-net
site

Satellite Satellite

PRIVATE MESSAGING NETWORK

Off-net
site
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Typical private messaging network
In a typical private messaging network, every switch is connected to a messa
server. Users connected to a switch have mailboxes and can exchange me
with other users connected to the same switch.

Users can also send messages to users on other switches in the network. T
capability is known as network messaging.

The messaging servers use a networking protocol, either analog or digital, 
communicate with one another.

Key terms
The following terms are used in discussions of NMS:

Term Definition

NMS network ■ The interconnected switches and the Meridia
Application Server

NMS site ■ An NMS network when it is part of a larger 
messaging network in which each site has its
own server

Prime switch location ■ The switch location directly attached to the 
Meridian Application Server

Satellite switch location ■ A switch location that is directly connected to
the prime switch

Tandem switch location ■ A switch location that is connected between 
the prime switch location and a satellite switch
location

User location ■ A logical grouping of mailboxes; may be the 
mailboxes on one switch or the mailboxes on
two or more switches
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NMS benefits

Introduction
An NMS network is not a typical private network. The network offers severa
unique benefits, including

■ cost savings

■ efficiency

■ transparency

■ flexibility

Cost savings
NMS connects several switches to a single Meridian Application Server. Sin
each switch does not require its own server, NMS offers considerable cost 
savings in both hardware and maintenance.

NMS enables you to have centralized administration, which helps control th
cost of ownership. Although the actual switch configuration must be comple
at each switch location, the configuration required to make the switches wo
with CallPilot is centralized.

From one Meridian Application Server, you can implement and maintain the
server and all switches in the NMS network.

Efficiency
With NMS, the spare capacity on a Meridian Application Server can be app
to more end-users. Users at locations that are too small to have their own 
dedicated messaging servers and switches can become part of an NMS ne
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Transparency
All users have a mailbox on the Meridian Application Server. Users on all 
switches in an NMS network have access to all multimedia messaging feat
and access them in the same way. The CallPilot feature operation is transp
to users. Users do not know that they are part of an NMS network.

This transparency is achieved by the configuration. User telephones on sat
switches are configured to call forward to the prime switch. The prime switc
configured to route NMS messages to CallPilot.

Flexibility
Because NMS can be combined with the other networking solutions offered
CallPilot, you can create a scalable messaging network that is customized 
meet your specific needs.
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Links and protocols

Introduction
NMS uses links and protocols to connect the parts of the NMS network and
transmit messages.

Prime switch location and satellite switch locations
The switches are connected by Integrated Service Digital Network (ISDN) 
primary rate access (PRA), and ISDN signaling link (ISL) trunks.

The prime switch communicates with the satellite switches with the D chan
of Primary Rate Interface (PRI) (64 kbit/s).

The prime switch location and the satellite switch locations communicate 
through virtual signaling to turn the Message Waiting Indicator (MWI) on a 
user’s telephone on and off. Virtual signaling is also used to transport nece
call information for a networking voice message feature, such as Call Send
These calls are supported by using ISDN noncall-associated transaction 
signaling messages.

Prime switch location and Meridian Application Server
The Meridian Application Server (MAS) is connected to the prime switch wi
two connections, one for voice and one for data. The Meridian Application 
Server communicates with the prime switch using the Application Module L
(AML) protocol. If the AML link fails, NMS calls are routed to the default ACD
DN configured for the CDN (DFDN).

Note: AML was previously known as Command and Status Link (CSL) and 
Integrated Services Digital Network/Applications Protocol link (ISDN/AP).
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NMS and users

Introduction
NMS is designed to be transparent to users. Users on one switch use the 
messaging system in the same way as users on all other switches and have
to the same features.

The only time NMS is not transparent is when a desktop user logs on to the
system.

Desktop user logon
When desktop users at non-NMS sites log on to CallPilot, they enter their 
mailbox number and their password only.

However, the first time desktop users at NMS sites log on to the system, th
must also select their location name from a drop-down list. The location nam
the name assigned to their switch location.

After the first logon, the selected location name becomes the default.
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NMS access mechanisms

Introduction
Three accessing mechanisms provide access to NMS services:

■ direct access

■ indirect access

■ offnet access

Direct access
The direct access offered to NMS users mirrors CallPilot direct access on o
networking solutions.

Direct access is initiated by a user dialing an NMS directory number, either
switch or network, or by pressing the Message Waiting key. Auto-logon on N
is supported if the call is initiated from the user’s station.

For a direct access call, the call is presented to CallPilot at the prime switch
through direct switches. This is a basic ISDN call that requires noncall-
associated ISDN Q.931 messages.

However, to support NMS features that require transaction signaling to trans
the noncall-associated information, such as Message Waiting Indicator 
notification and the Call Sender feature, the configuration between the 
originating switch and the prime switch must support the NMS transaction 
signaling transport. If the path used to transport the noncall-associated mes
is relayed through a switch that does not support NMS transaction signaling
NMS is not supported.
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Indirect access
Indirect access is initiated when a call is presented to NMS through call 
redirection. 

For any call redirected to NMS, the original called number from the ISDN Q.9
SETUP message is extracted when the call is forwarded to the prime switch
then passed to the Meridian Application Server. This allows CallPilot to 
distinguish the address of the original called party.

For a redirected network call, NMS uses the Network Call Redirection (NCR
feature to provide the original called number. The following Network Call 
Redirection types are supported:

■ network call forward all calls (NCFAC)

■ network call forward no answer (NCFNA)

■ network call forward busy (NCFB)

■ network hunting (NHUNT)

Indirect access requires the same NMS transaction signaling message.

Offnet access
NMS supports two types of offnet access.

A user can directly dial in to the prime switch where the Meridian Applicatio
Server resides.

A user can dial in to the user’s own switch to access a remote Meridian 
Application Server. For this type of offnet access, the user’s switch may nee
support direct inward system access (DISA). This allows the user to dial ano
network location after dialing in to the user’s own switch.
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NMS features and considerations

Introduction
All CallPilot features are available to users in an NMS network.

NMS features
The following table lists the CallPilot features that are supported by NMS:

CallPilot feature Supported

Call Sender Yes

Names Across the Network No

Name Addressing Yes

Name Dialing Yes

Personal Distribution Lists Yes

Shared Distribution Lists Yes

Multiple Recipients Yes

Reply To (compose messages) Yes

Reply All (reply to call answering messages) Yes

User’s Actual Personal Verification Yes

Administrator-Recorded Personal Verification Yes

Remote Site Spoken Names Yes

Private Tag Yes

Acknowledgment Tag Yes

Urgent Tag Yes

Received Time Announced Yes
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General considerations
The prime switch must be a Meridian 1 (Release 23C) switch.

Satellite switches must be either Meridian 1 switches or other compliant 
switches.

Capacity
A Meridian Application Server can support one prime switch and a maximum
59 satellite switches.

Signaling limitations
NMS is affected by several signaling limitations.

ISDN signaling limitations
NMS uses the signaling capabilities of the ISDN primary rate access (PRA)
the ISDN signaling link (ISL) to provide networking customers with messagi
services. Therefore, if a non-PRA or non-ISL trunk is involved in an NMS ca
the call cannot be completed.

Sent Time Announced Yes

99-Minute Messages Yes

Sender’s Name (text) Yes

Recipient’s Name (text) Yes

Message Subject (text) Yes

Sender’s Department Yes

Deferred Delivery Yes

CallPilot feature Supported
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Virtual signaling limitations
The prime switch and the satellite switches use virtual signaling to

■ Turn the Message Waiting Indicator (MWI) on and off.

■ Transport necessary call information for a networked multimedia 
messaging feature, such as Call Sender.

Virtual signaling is supported using ISDN noncall-associated transaction 
signaling messages. The FACILITY message with the TCAP protocol is use
transport information across the ISDN network.

End-to-end signaling limitations
End-to-end signaling (EES) is required to access CallPilot features from a 
satellite switch.

Dialing plans
NMS requires one of the following types of dialing plans:

■ Electronic Switched Network (ESN)

■ Coordinated Dialing Plan (CDP)

■ hybrid, which is a combination of ESN and CDP

Note: NMS does not support another dialing plan, such as public switched 
telephone network (PSTN).

Message center directory number
Only one message center directory number can be defined on each user 
telephone.

Local messaging server broadcast
NMS interprets a local messaging server message broadcast to include use
all switch locations in the NMS network.

This feature is especially useful if, for example, you want to inform users of
server shutdown.

Broadcast messages are not delivered to mailboxes that are configured to r
them. To avoid excessive resource usage, non-delivery notifications are no
generated for broadcast messages.
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Message transmission times
There are no message transmission times among switch locations, because
does not transmit messages among switch locations.

Every user on each switch is added as a mailbox user on the Meridian 
Application Server. The server functions as the message center of NMS. Wh
message is sent to more than one user, the message is deposited directly i
each user’s mailbox. There is no transmission to a satellite switch location.
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Feature interaction

Introduction
Many switch features interact with NMS. The following features interact with
ISDN Network Call Redirection (NCRD):

■ Call Forward (Unconditional, No Answer, and Busy)

■ Network Call Transfer

■ Network Hunting

■ Call Forward by Call Type Allowed to a Network DN

■ Attendant Extended Call

■ Call from CO Loop Start

■ Conference Call

■ Barge-in Attendant

Call Forward (Unconditional Call Forward, Call Forward No Answer, 
Call Forward Busy)

All three types of Call Forward are supported by the ISDN Network Call 
Redirection features. These are the basis for NMS indirect access.

In the case of an indirect NMS access call, the original called number and t
redirecting reason are extracted from the original called number information
element in the PRA SETUP message. The original called number and the 
redirected reason are put into the AML PCI message when presenting a ca
the Meridian Application Server.

If the original called number information element is not present, the redirect
information element is used instead. Similarly, the redirecting number and 
reason are extracted and transported to the server through a PCI message
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Network Call Transfer
Network Call Transfer is supported by the ISDN Network Call Redirection 
feature. If an NMS location is involved in a Network Call Transfer scenario, 
connected party number is extracted from the PRA NOTIFY message and 
into the AML DNP message when the transfer is complete.

The DN update message informs CallPilot that a call transfer has occurred.

Network Hunting
Network Hunting is supported by the ISDN Network Call Redirection feature
Indirect NMS access can be presented to CallPilot through Network Huntin
The messaging is the same as for Call Forward Busy. Therefore, the origin
called number information element in the PRA SETUP message is used to 
construct the ISDN/AP PCI message.

Call Forward by Call Type Allowed to a Network DN
The definition of the Call Forward by Call Type Allowed class of service is 
changed by the ISDN Network Call Redirection feature. This means that pri
network calls are treated as internal calls and are forwarded, using the Call
Forward No Answer feature or the Network Hunting feature, to the Flexible 
Directory Number or Hunt DN rather than to the External Flexible Number o
External Hunt DN.

The Call Forward feature is implemented through the ISDN Network Call 
Redirection feature. With this feature, the switch is able to provide different
messaging treatments for different types of calls, such as off-net calls inste
on-net calls.

A location can be configured so that all off-net calls are handled by a centra
attendant, while internal calls are handled by CallPilot. However, there is a l
of one message center DN for each location. This means that a user can b
served by two message centers, one that handles internal calls and one tha
handles external calls, but only one can control the Message Waiting Indica
(MWI) activation.
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Attendant Extended Call
Attendant Extended Call has an impact that is similar to Network Call Trans
There is one important difference, however. The DN update message is se
CallPilot when the attendant releases the call. Therefore, the connected pa
number is updated only when the attendant is released.

Call from CO Loop Start
Calls that come in to the switch from the CO Loop Start trunk cannot be 
redirected to another trunk through attendant extension or call redirection. T
calls should be blocked when redirection is activated.

The ISDN Network Call Redirection feature does not redirect calls from CO
Loop Start. Therefore, NMS does not support these calls.

Conference Call
When another party has a conference call with a CallPilot system, a DN up
message is sent indicating a conference call type. The connected party DN 
same as the station initiating the conference call, which is always the same 
DN in the PCI message.

If additional parties are added to the conference, no additional DNP messa
must be sent.

When a conference call drops back to a simple call, a DNP message is sen
indicating a simple call as call type and showing the remaining party as the
connected DN.

When the conference is established and is dropped at a satellite switch, a 
FACILITY message with TCAP protocol is transported to notify the prime 
switch of the conference call activities.

The DNP message is then triggered and sent to the Meridian Application Se

Barge-in Attendant
The attendant can barge in on an NMS call on the prime switch location. Du
barge-in, users cannot use the features that require switch effort, such as C
Sender.
NMS Implementation and Administration Guide 73



Getting started  Standard 1.00
74 CallPilot



November 1998 Getting started 
Dialing plans and NMS
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Overview 76
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Overview

Introduction
The dialing plan that connects the switch locations in a NMS network is 
fundamental to NMS.

NMS supports the following dialing plans:

■ Electronic Switched Network (ESN)

■ Coordinated Dialing Plan (CDP)

■ hybrid, which is a combination of ESN and CDP

Note: NMS does not support another dialing plan, such as PSTN.

Why dialing plans are important
It is important to understand how dialing plans work, because the dialing pl
used can affect the way your NMS network is implemented. As well, if the 
dialing plan is set up incorrectly, NMS cannot work.

The dialing plan can also affect the configuration of the switch locations.

See also
The following discussion assumes that you are familiar with the basic conce
of dialing plans. For a review of these concepts, consult the Networking 
Planning Guide.
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Dialing plans and NMS user locations

Introduction
The dialing plan used can affect the flexibility of configuring the user locatio
in an NMS network.

User location
A user location is a logical grouping of mailboxes. A user location may be th
mailboxes on one switch or the mailboxes on two or more switches.

ESN dialing plan
If the ESN dialing plan is used, there must be a one-to-one correspondence
switch locations to user locations.

CDP dialing plan
If the CDP dialing plan is used, there are two ways to define the correspond
of switch locations to user locations:

■ a one-to-one correspondence

■ an all-to-one correspondence

Define one switch location as one user location
Typically, each switch location is represented by a user location.

If this is done, ensure that there are no conflicts. For example, the same 
extension cannot exist on two different switch locations.
NMS Implementation and Administration Guide 77
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The following diagram shows a one-to-one correspondence between switch
locations and user locations.

Define two or more switch locations as one user location
By defining two or more switch locations as one user location, you do not h
to check for conflicts. This option also allows you to maximize the number o
users supported.

You can combine all switch locations into one user location, or you can com
some switch locations into one user location.

Defining one user location offers the following advantages:

■ Configuration of satellite switch locations is simplified.

■ Configuration of phantom DNs for services at all locations is simplified.

However, defining one user location has the following disadvantage:

■ The spoken name for each individual location is lost.

G100987.eps
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In the following diagram, two switch locations are combined into one user 
location.

How two or more switch locations are combined into one user 
location

When implementing NMS, if each switch location is a user location, on 
CallPilot you add and configure each satellite switch. However, each switch
configured individually.

To combine two or more switch locations into a single user location, you ad
and configure only one satellite switch location. The CDP steering codes fo
switch locations are added to a single list.

Restriction
A switch location can have a maximum of 500 CDP steering codes. If, by 
defining a single user location, you require more than 500 CDP steering co
you cannot use this option.

G100988.eps
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NMS dialing restriction scenarios

Introduction
An NMS network requires a uniform dialing plan. This requirement has 
important implications for implementing an NMS network. In some cases, it
may require reconfiguration of an existing dialing plan.

Uniform dialing plan
The uniform dialing plan requirement must be considered in the following 
scenarios:

■ calls to other users in the NMS network

■ calls to other users at other sites in the private messaging network but
part of the local NMS site

■ calls to public switched telephone network (PSTN) users beyond the pri
messaging network

Dialing restrictions for calls within an NMS network
Dialing among all users on all switches in an NMS network must be done 
uniformly. The only exception is that the ESN access code may be differen

Dialing restrictions for calls within a private messaging network
A uniform dialing plan is also necessary when an NMS network is a site in a
larger private messaging network.

Dialing from all users on all switches in an NMS network to a remote site in
private network must be completed uniformly. The only exception is that the
ESN code may be different.
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Dialing restrictions for calls beyond the private messaging network
A uniform dialing plan is also necessary to make calls from an NMS networ
PSTN users.

Dialing from all users on all switches in an NMS network to a PSTN site, wh
is not part of the private network, must be completed uniformly. The only 
exception is that the ESN code may be different.

Implications of the dialing restriction for calls beyond the private 
network

The uniform dialing plan restriction has important implications that must be 
considered when implementing an NMS network.

For all switches in an NMS network to dial PSTN destinations in the same w

■ All switches in the NMS network must be located in the same city/area
code.

■ All switches must be located in proximity to one another (that is, within 
same PSTN local calling area).

■ All switches must use the same prefixes to reach the PSTN.

If these requirements are not satisfied, when a user on a satellite switch in 
NMS network dials a PSTN destination using features such as Thru-Dial, C
Sender, and Remote Notification, the message may not be delivered. This 
because, although the call is made at a satellite switch location, the call is 
actually dialed from the prime switch location.

These implications do not affect users on the prime switch location.

Note: While CallPilot is supported, calls may not work.

All switches must be located in the same city/area code
Switches in different city/area codes cause problems.

Example: Switch A is the 416 city/area code and switch B is in the 905 city/a
code. To dial from switch A to (416)597-1234, a user dials 95971234. Howe
a user on switch B must dial 914165971234. 

All switches must be in the same calling area
Numbers that require different dialing from different switches cause problem
NMS Implementation and Administration Guide 81
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Example: To reach the PSTN number (905)555-1234, a user on switch A c
dial 919055551234. A user on switch B, however, can dial only 95551234. 
Because the switches have different local and long-distance dialing areas a
use different dialing formats to reach the same PSTN number, the dialing pl
not uniform.

All switches must use the same prefixes to reach the PSTN
Switches that do not use the same prefixes to reach the PSTN may cause 
problems.

Example: All switches in the NMS network must use the same local, long-
distance, and international dialing prefixes. If users on switch A dial 61 for lo
distance and users on switch B dial 71, the dialing plan is not uniform.

CDP dialing plan restriction
If a CDP dialing plan is used, the CDP code must overlap the mailbox num
sufficiently.

Hybrid dialing plan requirements
If a hybrid dialing plan is implemented in the NMS network, the following 
requirements must be met:

■ All switches must support ESN and have ESN prefixes.

■ The prime switch must support both ESN and CDP.

■ CDP can exist on any satellite switches.

■ The general restrictions that apply to CDP also apply to CDP when use
a hybrid dialing plan.

Considerations
If all CDP switches share the same ESN prefix, configure the prime switch 
represent all of the switches that are part of CDP.

If each CDP switch has its own ESN prefix, or prefixes, create a location fo
each ESN switch in the network. That is, group the switches by ESN prefixe
82 CallPilot
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Overview

Introduction
Successful implementation of NMS requires planning and preparation. A pl
that specifies the objectives and functionality of the networking implementa
is important.

Before you begin to implement NMS, you should understand the basic 
implementation process and what you are expected to do.

All steps in the implementation process are described in more detail in the 
following chapters.

Before you begin
NMS is an incremental installation onto your CallPilot system.

This guide assumes that the following preliminary requirements are met:

■ The prime switch is installed and configured.

■ The satellite switches are installed and configured.

■ CallPilot is installed and configured, except for NMS.

■ Sufficient trunks connecting the prime switch to a public switch are 
available.

■ If the implementation is an upgrade from Meridian Mail, all legacy 
information is available.

Implementation process
The main steps in the implementation process are

■ gathering information (Chapter 3, Gathering information)

■ configuring the switch locations (Chapter 4, Configuring the switches)

■ configuring CallPilot on the Meridian Application Server (Chapter 5, 
Configuring CallPilot for NMS)

■ testing and backing up the system (Chapter 6, Testing and backing up 
NMS)
84 CallPilot
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Gather information

Introduction
Before you implement NMS, you must understand how the network will wor
and how users will dial one another.

If the implementation is an upgrade
If CallPilot NMS is an upgrade from an existing NMS setup or is being adde
an existing site, information must be gathered about the existing site. When
possible, the information will be reused so that the implementation of CallP
NMS will be transparent to users, and they will continue to use the system 
they always have.

If the implementation is a new network
If NMS is a new implementation, this information must be created. Informat
about the administrative setup should be gathered first so that there are no
conflicts. For example, prefixes used to dial an exterior number, a long-dista
number, or an international call should be gathered. 

Much of the required information depends on the dialing plan that will be us
If CallPilot NMS is replacing a current system, usually the existing dialing p
will be re-created. If CallPilot is a new implementation, the choice of dialing
plan depends on how the system will be used.

Recommendation
An ESN dialing plan is recommended over a CDP dialing plan.

An ESN dialing plan has several advantages, including the following:

■ easier to maintain

■ easier to add new sites

■ minimal conflicts with numbering plans
NMS Implementation and Administration Guide 85
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Configure the satellite switches

Introduction
Although all satellite switches must be installed and configured before you b
to implement NMS, you must make additional changes to the satellite switc
configurations.

Satellite switches must forward to the prime switch
Phantom directory numbers (DNs) have been set up on the prime switch. T
phantom DNs are used by the switch to route calls to services. Phantom DN
forward incoming calls to the appropriate CDN queues on the prime switch 
further call handling.

By creating a phantom DN for CallPilot services, every service has a uniqu
number that users dial. Some services, such as Integrated Voice and Fax, m
configured to use the CDN numbers directly.

To make the services that are available to users on the prime switch availa
users on the satellite switches, the phantom DNs on the satellite switches m
be configured to forward to the ACD queues on the satellite switch. In turn,
ACD queues on the satellite switch forward to the CDN queues on the prim
switch.

Phantom DNs and NMS
To access a CallPilot service, a user enters a unique dialable number. The s
uses this number to begin routing the call to the requested service.

The call is routed to ACD queues on the satellite switches and then to CDN
queues on the prime switch location.

Determine the CDN queues on the prime switch
You must know the CDNs used on the prime switch to configure the phanto
DNs and ACD queues on the satellite switches.

Ask the switch technician responsible for configuring the prime switch locat
for this information.
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NMS network configuration

Introduction
NMS configuration consists of adding information about the Meridian 
Application Server, the prime switch location, and all satellite switch locatio
to the database.

Prime switch location configuration
When you configure the prime switch location for NMS, you complete the 
required information on the Messaging Network Configuration—Local Prim
Switch dialog box.

Configuration consists of providing general information about the switch 
location, such as name and server type, as well as detailed information abo
dialing plan used.

Satellite switch location configuration
When you configure a satellite switch location, you complete the required 
information on the Messaging Network Configuration—Satellite Switch dialo
box.

Configuration consists of providing general information about the switch 
location, such as name and server type, as well as detailed information abo
dialing plan used.

You must also configure the phantom DNs and ACD queues on the satellite
switch locations.

After adding a phantom DN for a satellite switch, you must add an entry to 
SDN Table on the prime switch location.

Meridian Application Server configuration
There are two main steps to configuring the Meridian Application Server:

■ adding and configuring inbound SDNs for all services provided by all 
switch locations

■ configuring the messaging network configuration information
NMS Implementation and Administration Guide 87
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SDNs
Although the Service Directory Number (SDN) Table on the Meridian 
Application Server is already set up and configured, you must make addition
the table for NMS after configuring the phantom DNs and ACD queues on t
satellite switch locations.

Messaging Network Configuration
Configure the local Meridian Application Server for NMS by completing the 
required information on the Messaging Network Configuration—Local Serv
dialog box.

Test and back up the system
Test the NMS network to ensure that the system is properly configured and
sending messages as expected.

After the system is tested, perform a backup. The backup ensures that the p
configuration is not lost in the event of a system failure.

See also
If you require additional information about the general implementation proc
consult the Networking Planning Guide.
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NMS site configuration 

Introduction
If the NMS network is a site in a larger messaging network, it is called an N
site.

The first steps in configuring of an NMS site are the same as those for 
configuring an NMS network. In fact, first you set up an NMS network, and th
you add it to the messaging network as a site, specifying the protocol or 
protocols that the NMS site uses to communicate with other sites in the 
messaging network.

Recommendation
Plan the entire messaging network before configuration to ensure that there
no conflicts with any other sites in the messaging network.
NMS Implementation and Administration Guide 89
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Example
The following example illustrates two NMS sites, Site 5 and Site 6, in a 
messaging network. In this example, suppose you are the administrator of S

In addition to NMS, you know that you are implementing Enterprise 
Networking, AMIS Networking, and Integrated AMIS Networking on your 
system. You know which sites you will communicate with using each protoc

You begin by implementing NMS on Site 6. Once completely implemented 
tested, you provide all details of the configuration to the administrators of th
remote sites as part of a general information-sharing and -gathering proces

The network administrator at Site 5 also implements and tests NMS.

When both Site 5 and Site 6 have NMS implemented, configuration informa
is shared with all other sites in the messaging network.

Only after the NMS network implementation is complete and all the require
information is gathered can you begin to implement the other networking 
solutions.

G101139.ep
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Gathering information

This chapter describes how to gather the information that is required to 
implement NMS. 

The chapter also describes how to create a representation of the NMS netw

In this chapter
Required information 93

NMS network representation 95
NMS Implementation and Administration Guide 91
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Required information

Introduction
Before you begin to implement NMS, gather the information that is required
configure the system. 

This information specifies how the switches in the NMS network communic

Required information
Information is required from the prime switch location and each satellite sw
location.

Prime switch location information
The following information is required:

■ switch location name

■ dialing plan used

● ESN

● CDP

● hybrid, combining ESN and CDP

■ dialing plan information

● ESN dialing plan:

- ESN access codes

- number of overlapping digits between ESN prefix and local extens

- ESN prefix, including the access code

● CDP dialing plan:

 - number of overlapping digits between CDN steering code and loc
extension

 - CDP steering code

● hybrid dialing plan, combining ESN and CDP dialing plans

■ extension numbers used (necessary to avoid conflicts with any codes a
prefixes used)

■ information about existing CDNs and phantom DNs defined on the swi
NMS Implementation and Administration Guide 93
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Satellite switch location information
The following information is required:

■ switch location name and number

■ dialing plan used

● ESN

● CDP

● hybrid, combining ESN and CDP

■ dialing plan information

● ESN dialing plan:

- ESN access codes

- number of overlapping digits between ESN prefix and local extens

- ESN prefix, including the access code

● CDP dialing plan:

 - number of overlapping digits between CDN steering code and loc
extension

 - CDP steering code

● hybrid dialing plan, combining ESN and CDP dialing plans

■ extension numbers used (necessary to avoid conflicts with any codes a
prefixes used)

■ information about existing phantom DNs and dummy ACD queues defi
on the switch
94 CallPilot
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NMS network representation

Introduction
A representation of the NMS network summarizes how the NMS network is
up. It contains information about each of the switch locations and the Merid
Application Server, and indicates the relationships among them.

If sufficiently detailed, a representation of the NMS network is the primary 
source of information consulted during implementation.

For most NMS networks, a diagram is the most suitable form of representa
For a very large NMS network, however, a spreadsheet is more appropriate

Purpose
A detailed diagram or spreadsheet is useful because it contains all of the 
information you require to implement NMS. During implementation, you ent
information from the representation into the network database.

In many ways, the representation is your implementation blueprint.

Benefits
There are many benefits to creating a representation of your messaging net
A representation

■ offers a clear view of how your network is connected

■ provides an opportunity to determine if there are any conflicts

■ gathers all required information in one place

■ provides useful information when planning future modifications

■ helps during the analysis of traffic issues

■ reveals areas where the network could be improved

■ provides support personnel with a concise, clear view of the network
NMS Implementation and Administration Guide 95
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Sample NMS diagram
The following diagram illustrates a simple NMS network. The dialing plan is
CDP. Each switch location is defined as a distinct user location.

Protecting the representation
Your network representation contains sensitive information. It should be 
properly stored and protected as part of normal security procedures.

See also
For more information on creating network diagrams, consult the Networking 
Planning Guide.
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Configuring the switches

This chapter describes how the prime switch location and the satellite switc
locations are configured to implement NMS.

The chapter introduces the concepts that are necessary to understand the 
configuration process and provides detailed configuration procedures.

In this chapter 
About switch configuration 99

Configuring the switch locations 103
NMS Implementation and Administration Guide 97
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About switch configuration

In this section
Switches and NMS 100

Confirming the Network Class of Service 101
NMS Implementation and Administration Guide 99
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Switches and NMS

Introduction
Switches provide the call handling required by CallPilot.

All switches that are used by NMS are already configured and tested when
begin to implement NMS.

However, you must check this configuration to determine if it is suitable for 
NMS. You must also do additional configuration to enable functionality that
required by NMS.
100 CallPilot



November 1998 Configuring the switches 

s of 

 

tem 

all 
Confirming the Network Class of Service

Introduction
On each switch location in the NMS network, confirm that the Network Clas
Service (NCOS) level is adequate for NMS.

If an NCOS level is inadequate, NMS may not work.

Definition: Network Class of Service
A Network Class of Service level is a switch setting that controls access to 
trunks and call queuing. It also provides users with expensive route warning
tones.

NCOS and NMS
NMS requires that the system be able to dial within the NMS network. 
Therefore, ensure that the NCOS level is sufficient to support a CallPilot sys
with all features.

The NCOS level must allow the system to dial out of a switch location for C
Sender and Thru-Dial, but not create possible security breaches.

See also
For detailed information about NCOS levels, including how to check their 
current setting and make adjustments if required, refer to your switch 
documentation.
NMS Implementation and Administration Guide 101
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Configuring the switch locations

In this section
Overview 104

Dummy ACD-DNs on satellite switch locations 106

Phantom DNs and SDNs in an NMS network 107

Switch overlays 110

Prime switch configuration 111

Configuring satellite switch locations 113

Configuring telephones of users on satellite switch locations 117

Upgrade an existing satellite switch 118

SDN Table and NMS 119

Services not in the SDN Table 122

Adding and configuring SDNs in the SDN Table 123
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Overview

Introduction
NMS provides the same CallPilot services to users on satellite switches tha
available to users on the prime switch. NMS provides these services 
transparently. That is, users receive the same services without having to en
any additional numbers, regardless of which switch they are on.

To provide these services, the switches and the server in the NMS network 
be carefully configured.

Configuring the prime switch location and the satellite switch locations is a 
major step in implementing an NMS network.

Skill requirements
Configuring switches for NMS should be done by an experienced switch 
technician.

Assumptions
This guide assumes that you have a basic understanding of how the prime s
is set up and how it interacts with the server to provide requested services.

You should understand the following terms:

■ service directory numbers (SDNs)

■ controlled directory numbers (CDNs)

■ phantom directory numbers (phantom DNs)

For a review of these concepts, consult the relevant sections in the Advanced 
Administration Guide.
104 CallPilot



November 1998 Configuring the switches 

ing 

e 

e 

.

must 
Before you begin
Implementing NMS is an incremental process.

Before you begin to configure the switches in your NMS network, the follow
should be complete:

■ The Meridian Application Server is installed and configured. The SDN 
Table contains all local SDNs.

■ The prime switch location is installed and configured. The CDNs and th
phantom DNs are set up.

■ The satellite switch locations are installed and configured. However, th
phantom DNs and the dummy ACD-DNs must be set up.

■ Adequate trunks are installed on all switch locations.

Administrator cooperation
Configuring the switch locations in an NMS network requires cooperation 
among the administrators of all switch locations.

The following process is recommended:

■ Gather the required information from the prime switch.

■ Configure each satellite switch based on the gathered information.

■ Complete the configuration of the SDN Table on the messaging server

See also
For a general discussion of phantom DNs, SDN Tables, and how switches 
be configured for CallPilot, consult the relevant sections in the Advanced 
Administration Guide.
NMS Implementation and Administration Guide 105



Configuring the switches  Standard 1.00

 

te 

ight 
ls 

one 
n, 
Dummy ACD-DNs on satellite switch locations

Introduction
CDNs exist on the prime switch only. Satellite switch locations have dummy
ACD-DNs.

A dummy ACD-DN forwards a request for a service by a user on the satelli
switch location to a CDN on the prime switch.

To provide the service, a dummy ACD-DN forwards the request through a n
call forward (NCFW) DN. The NCFW DN determines the CDN to which cal
are routed.

Number of dummy ACD-DNs required
The number of dummy ACD-DNs on a satellite switch location must be the 
same as the number of CDNs on the prime switch.

For example, if there are two CDNs on the prime switch, one for voice and 
for fax, there must be two dummy ACD-DNs on each satellite switch locatio
one for voice and one for fax.
106 CallPilot
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Phantom DNs and SDNs in an NMS network

Introduction
You must understand how the switch locations handle messages to unders
the switch configuration that is required for NMS.

All switch locations in an NMS network have phantom directory numbers 
(DNs). 

The phantom DNs of satellite switch locations are configured differently from
the phantom DNs of the prime switch location.

Interrelationships
The following diagram illustrates the relationship among the phantom DNs o
satellite switch location, the dummy ACD-DNs on a satellite switch location, 
CDNs on a prime switch location, and the SDN Table. 
NMS Implementation and Administration Guide 107
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The phantom DNs of the prime switch location are set up before you begin 
implement NMS. Information about the configuration is required to set up th
phantom DNs on the satellite switch locations. The SDN Table already exist
the messaging server. You add additional entries to the table for the service
provided on each of the satellite switch locations.
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Satellite switch location phantom DNs
The phantom DNs of the satellite switch location are separately defined on 
satellite switch.

This allows users on the satellite switch to dial a local number rather than u
the prime switch phantom DNs with a prefix. For example, a user enters 
63388000 for Express Messaging.

In this diagram, the phantom DNs of the satellite switch location are set up 
that users on any switch location can use the same digits to access the ser
However, this is not a requirement. Different phantom DNs and dummy AC
queue numbers can be used on the satellite switch as long as the correspo
network numbers are entered in the SDN Table.

SDN Table
The SDN Table on the messaging server contains the SDNs that correspon
the phantom DNs, CDNs, and dummy ACD queues of both the satellite swi
locations and the prime switch location.

The number dialed is used to locate the requested service. In the diagram, 
3397000 matches the Voice Messaging Service for the satellite switch loca
A user on a satellite switch dials 7000 to reach the service, but the SDN 
configuration must contain the number in the network format as seen by the
prime switch (for example, 3397000).

The SDN is the dialable number that provides the service to the user on the
satellite switch location.

Satellite switch location SDNs
The dialing plan prefix distinguishes the SDNs for satellite switch locations 
from the SDNs for the prime switch location.

If an ESN dialing plan is used, the satellite switch location SDN entries do n
include the ESN access code. Only the location code is required.

Example: If the ESN access code is 6, the location code is 339, and the DN
8000, enter 3398000 for the service in the SDN Table.
NMS Implementation and Administration Guide 109
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Switch overlays

Introduction
Satellite switch locations for NMS are configured on the following overlays:

Responses to overlay prompts
To program an overlay, you respond to a series of prompts. The procedure
this section mention only those prompts that are relevant to NMS. You mus
respond to these prompts in a certain way.

Any prompt that is not mentioned can be programmed in any way. To accep
default value for other prompts, press Enter.

When working with overlays, follow the general steps below.

To work with overlays

1 Load the appropriate overlay.

2 Respond to prompts as shown in the tables in this section. 

3 Press Enter after each prompt until you get to the next one to be defined.

4 When configuration is complete, enter **** in response to the REQ prompt.

Result: You exit the overlay.

Task Overlay

Define a dummy ACD-DN. 23

Configure a phantom DN. 10
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Prime switch configuration

Introduction
The prime switch provides the call handling services required by NMS. All 
requests for services from the satellite switch locations are forwarded to the
prime switch location.

The configuration of a satellite switch location must be coordinated with the
configuration of the prime switch location. Gather configuration information 
from the prime switch location before configuring a satellite switch location.

Required information
You must gather complete details of the configuration of the CDNs and phan
DNs on the prime switch location. This information is used to configure a 
satellite switch location.

Phantom DNs
While some services are accessed by directly dialing a CDN, many service
accessed by dialing a phantom DN.

A phantom DN forwards incoming calls to a controlled directory number (CD
for further call handling. A phantom DN is created for each service offered b
the switch. This ensures that each CallPilot service has a unique number th
users dial.

Example
A user dials 8000 to access Express Messaging and 7040 to access Fax It
Maintenance. Phantom DNs must exist for both services.

Determine the CDNs and the phantom DNs on the prime switch
You must know the CDNs and the phantom DNs used on the prime switch 
configure the phantom DNs on the satellite switches.

Ask the switch technician for a complete list of the CDNs and the phantom D
as well as the services they provide.
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Coordinate with the administrators of satellite switches
The administrators of the satellite switches must know the phantom DNs us
on the prime switch.

Ensure that every administrator has a complete and accurate list of the pha
DNs and the services they provide.

See also
For detailed information about phantom DNs and how a switch must be 
configured for CallPilot, consult the relevant sections in the Advanced 
Administration Guide.
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Configuring satellite switch locations

Introduction
Although the satellite switch locations are installed and set up before you 
implement NMS, some additional configuration is required.

The additional configuration consists of two main steps:

■ Configure the dummy ACD-DNs to forward to the CDNs on the prime 
switch.

■ Configure the phantom DNs to forward to the dummy ACD-DNs.

Note: The procedures that follow are for new satellite switch locations. If yo
are upgrading an existing satellite switch location, review the section Upgrade 
an existing satellite switch on page 118.

Before you begin
You must know the CDNs and phantom DNs that are used on the prime sw
location to configure the phantom DNs and dummy ACD-DNs on the satelli
switch locations.

Define the dummy ACD-DNs
Define a dummy ACD-DN for each media type used.

Usually, for each type of CDN on the prime switch, there is a corresponding
dummy ACD-DN on the satellite switch. 

If this is on the prime switch Then this is on a satellite switch

CDN

Media type: Voice

Dummy ACD-DN

Media type: Voice

CDN

Media type: Fax

Dummy ACD-DN

Media type: Fax

CDN

Media type: Speech recognition

Dummy ACD-DN

Media type: Speech recognition
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If a satellite switch does not provide any of the services provided by a type 
CDN queue, it is not necessary to define a dummy ACD-DN. For example, 
satellite switch does not provide any speech recognition services, a speech
recognition dummy ACD-DN is not required.

Setting the dummy ACD-DNs to night call forward
Every dummy ACD-DN must be configured to night call forward to the 
corresponding CDN on the prime switch location.

The forwarding address must be in network format. For example, to night c
forward to 63387000,

■ ESN access code = 6

■ Location code of prime switch = 338

■ Voice CDN on prime switch = 7000

By configuring night call forwarding in this way, users on the satellite switch
location can access the CallPilot service by entering the local satellite switc
ACD queue number, 7000. They do not have to explicitly dial the CDN on t
prime switch location.

To define a dummy ACD-DN on a satellite switch

1 Load overlay 23. 

2 For each prompt listed in the following table, enter the response indicated. 
For prompts that are not listed, click Enter to accept the default.

Prompt Response Description

REQ NEW Indicates creation of a new DN

TYPE ACD

CUST 0

ACDN x...x For example, 7000

■ 7 digits maximum length

MWC YES Indicates this is a message center DN
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3 To define another dummy ACD-DN, at the REQ prompt enter YES.

4 To exit the overlay, enter ****.

Phantom DNs
Add phantom DNs for services that you want available at that satellite switc
location.

Note: You can add additional phantom DNs to account for additional servic
that you plan to implement in the future.

Add phantom DNs
For detailed instructions on how to add a phantom DN to a satellite switch 
location, consult the Advanced Administration Guide. The procedures for 
entering phantom DNs on the prime switch are the same as the procedures
entering phantom DNs on a satellite switch.

Forward phantom DNs
Every phantom DN that is added to a satellite switch location must be call 
forwarded to the dummy ACD-DN on a satellite switch.

MAXP 1 Even though there is no agent for this DN, one is 
required

NCFW x...x Night call forwarded DN

■ up to 31 digits, network number of CDN on the
prime switch

Prompt Response Description
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To forward a phantom DN

1 Load overlay 10.

2 Define the phantom DNs to default call forward to the dummy ACD-DN. At 
the FTR prompt, enter DCFW, the number of digits in the default forward 
DN (only certain values are accepted), and the default DN.

Example: FTR DCFW 4 7000 (where 7000 is the dummy ACD-DN on the 
satellite).

3 To exit the overlay when configuration is complete, enter **** at the REQ 
prompt.
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Configuring telephones of users on satellite 
switch locations

Introduction
To configure a user’s telephone on a satellite switch, you use a procedure si
to the one used on the prime switch. However, on a satellite switch, a dumm
ACD-DN is used instead of a CDN.

The local ACD-DN is specified as the local forward DN and the Hunt DN for 
user’s phone. The same DN is also defined as the message center DN on t
Message Waiting key.

Example

■ FDN 7000

■ HUNT 7000

■ KEY 8 MWK 7000

To configure a telephone

1 Load overlay 11.

2 For each prompt listed in the following table, enter the response indicated. 
For prompts that are not listed, click Enter to accept the default.

3 To exit the overlay, enter ****.

Prompt Response Description

FDN xxxx ACD-DN (at the satellite switch) as forward-no-
answer DN

HUNT xxxx Hunt to ACD-DN

KEY 8 MWK xxxx ACD-DN as message center DN
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Upgrade an existing satellite switch

Introduction
The configuration of satellite switches for NMS in CallPilot is different from t
configuration for Meridian Mail.

Meridian Mail uses dummy ACD-DNs, rather than phantom DNs, to forward
call to another ACD-DN on a satellite switch. These ACD-DNs forward to 
ACD-DNs for Meridian Mail on the prime switch.

If you are upgrading an existing system, you must decide how you will config
the satellite switches. You can either reuse the existing legacy configuration
reconfigure the system.

Continued use of ACD-DNs
To continue to use the dummy ACD-DNs instead of phantom DNs with 
CallPilot, make sure that the ACD-DN that is forwarded to is, in turn, 
configured to night call forward to the CDN on the prime switch, specified in
network format.

For the procedures for night call forwarding the dummy ACD-DNs, consult 
original switch documentation.

Upgrade to phantom DNs
You can also upgrade the existing dummy ACD-DNs and replace them with
phantom DNs.

To upgrade the system, follow the procedure in Configuring satellite switch 
locations on page 113.

Remove the unused dummy ACD-DNs.
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SDN Table and NMS

Introduction
A Service Directory Number (SDN) Table already exists on the Meridian 
Application Server. It contains all of the SDNs required by the prime switch

However, you must add entries to the SDN Table to satisfy the needs of the
satellite switch locations. These additional entries are the services used at 
of the satellite locations.

After all satellite switch locations are configured, their phantom DNs and 
dummy ACD-DNs must be added to the SDN Table.

Definition: SDN
A service directory number (SDN) enables a user to access a CallPilot serv
Each SDN must be unique so CallPilot can identify the requested service a
play the appropriate prompts.

SDNs and NMS
The services offered by the prime switch location must be available to the 
satellite switches. For this reason, SDNs corresponding to the services offe
by the satellite switches must be added to the SDN Table.

Inbound SDNs
In an NMS site, the satellite switch locations require only inbound SDNs. An
inbound SDN is a directly dialable number used to access services.
NMS Implementation and Administration Guide 119



Configuring the switches  Standard 1.00

gs.

The 

a 
e 

. In 
SDN Table
The SDN Table is created during the initial installation of CallPilot on the 
server. The SDN Table lists all SDNs and provides details about their settin

CallPilot uses the SDN Table to map directory numbers (DNs) to services. 
SDN Table lists both inbound and outbound SDNs.

Example
The following SDN Table contains the SDNs for both the prime switch and 
satellite switch. The satellite switch SDNs consist of two main parts: the sam
SDN used for the prime switch, and the location code of the satellite switch
this example, an ESN dialing plan is used. 
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Satellite switch SDNs
The services provided on the satellite switches are entered in the SDN Tab
the CallPilot server.

To enter a satellite switch SDN, you must know the phantom DNs and ACD
DNs that are set on the satellite switch, and the location codes of the switch
the dialing plan. Usually (for example, if an ESN dialing plan is used) the 
phantom DNs on the satellite switches are numbered the same as those on
prime switch.

For an example of satellite switch SDNs, see the diagram under Phantom DNs 
and SDNs in an NMS network on page 107.

See also
For detailed information on SDNs and SDN Tables, consult the relevant sec
in the Advanced Administration Guide.
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Services not in the SDN Table

Introduction
All directly dialed services, such as Express Messaging, must have a 
corresponding entry in the SDN Table.

However, Call Answering services do not have an entry and are treated as 
special case. These services do not have an entry because the number dia
example, a user’s telephone number) is not in the SDN Table.

Since the dialed number is not found, the CDN used to route the call to Call
is used to determine the appropriate type of call answering service to start.

CDNs used
The CDNs are the prime switch CDNs, even for call answering calls from 
satellite locations. Typically, two CDNs are used. One CDN is for call answe
with the Multimedia Messaging service configured against it, with the media
type set to Voice. The second CDN is for voice and fax call answering with 
Multimedia Messaging service configured against it, with the media type se
Fax.

A result of this configuration is that even if fax call answering is used only o
satellites, a corresponding CDN queue and SDN entry for Multimedia (fax 
media) must be configured.
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Adding and configuring SDNs in the SDN 
Table

Introduction
NMS requires inbound and outbound SDNs for the services available on ea
satellite switch location as well as the services available on the prime switc
location. Outbound SDNs are created automatically by the system.

Inbound SDNs
An inbound SDN is not created automatically. You must add and configure e
one.

Before you begin
The SDN number must correspond to a dummy ACD-DN or phantom DN on
switch. Therefore, make sure you know these numbers before beginning th
configuration.

Note: The voice or fax call answering on a satellite switch location uses the
CDN on the prime switch location and is therefore not added to the SDN Ta

SDN format for prime switch location
When adding SDNs for services at the prime switch location, enter them in l
format.

Example
Create an SDN for Express Messaging at the prime switch location with a 
phantom DN of 8365.
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SDN format for satellite location
When adding an SDN for a service at a satellite location, the SDN must be 
network format that is dialable from the prime location (when prefixed with t
access code) because this is the number the switch passes to CallPilot.

Therefore, the SDN must include the ESN location code or the CDP steerin
code for the satellite switch location.

Example

■ ESN location code for satellite = 444

■ Phantom DN for express messaging on satellite = 3544

■ SDN for express messaging = 4443544

Getting there  Nortel SMI > Meridian Application Server > System Configuration 
> Service Administration > Service Directory Number
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To add and configure a new inbound SDN

1 From the SDN Table, select New from the File menu.

Result: The New Inbound Service Directory Number Properties dialog box 
appears.

2 On the General tab, enter the SDN number in the Service DN box.

Note: This number must correspond to a CDN or phantom DN on the 
switch.

3 Select an application from the Application Name list.

Result: The corresponding application ID appears above the application 
name in the Application ID box.

4 Select the type of channel required by the service in the Media Type list.

5 If you want to reserve a minimum number of channels for the service, enter 
the number in the Minimum Channels box.

6 Do one of the following:

■ Select the Use Default Maximum box. 

Note: This is the recommended option.
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■ Enter the maximum number of channels that a service can use at one 
time in the Maximum Channels box.

Note: The maximum number of channels cannot exceed the total number 
of channels available on the server. If you enter a number larger than the 
total number of channels, a warning box appears asking you to change the 
number.

7 Enter any comments in the Comments box.

8 Click Save to add the SDN to the SDN Table.

9 Repeat steps 1–8 for every phantom DN and dummy ACD-DN on every 
satellite switch location.
126 CallPilot



n 
c h a p t e r  5

Configuring CallPilot for NMS

This chapter describes how to configure CallPilot during the NMS installatio
process. 

The chapter introduces the concepts that are necessary to understand the 
configuration process and provides detailed configuration procedures.

In this chapter 
Configuring the Meridian Application Server 129

Configuring the switch locations 137

Additional administrative tasks 157
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Configuring the Meridian Application 
Server

In this section
Overview 130

Configuring the local messaging server 132
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Overview

Introduction
The implementation of NMS requires additional configuration of CallPilot. Th
configuration determines how the switch locations of an NMS site exchange
messages.

The configuration process consists of three main steps:

■ configuring the Meridian Application Server

■ configuring the prime switch location

■ adding and configuring each satellite switch location in the messaging 
network 

CallPilot automatically assigns the prime switch location to the Meridian 
Application Server. The prime switch location requires additional configurat

Each satellite switch location must be manually added. Each requires 
configuration.

Before you begin
Before you begin to configure CallPilot, your switch locations must be 
completely set up and properly configured. The SDN Table must contain al
necessary entries.

Dialing plan information is an important part of the configuration process. A
dialing plan information must be gathered and available before beginning.

Use your messaging network representation as a guide for entering require
information.

ATTENTION! It is strongly recommended that you perform each step 
the configuration process in the order presented.
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Recommended procedure
Configure the prime switch location before configuring the satellite switches

The process of configuring the prime switch location is almost identical to th
process of configuring a satellite switch location.

Capacity
A Meridian Application Server with NMS can support one prime switch 
location and up to 59 satellite switch locations.

Messaging Network Configuration tree view
The Messaging Network Configuration tree view contains a graphical 
representation of your NMS network. The tree view shows the local Meridia
Application Server and all switch locations.

Use the tree view to gain access to the Properties dialog boxes where you 
configure the Meridian Application Server and the prime switch location, an
add and configure the satellite switch locations.

See also
For a detailed discussion of the Messaging Network Configuration tree view
the Properties dialog boxes, consult the Networking Planning Guide.
NMS Implementation and Administration Guide 131



Configuring CallPilot for NMS  Standard 1.00

r 
 

Configuring the local messaging server

Introduction
When CallPilot is initially installed on your system, a Meridian Application 
Server and local switch location are automatically added to the Messaging 
Network Configuration tree view.

The Meridian Application Server must be configured. Configuring the serve
consists of saving general information about the server, such as name and
description, to the network database.

The local messaging server is configured on the Local Messaging Server 
Properties—General tab.
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If another messaging solution is installed
If Enterprise Networking, VPIM Networking, or both are installed on the loca
server, you must add placeholders to certain boxes on the Messaging Netw
Configuration—Local Server dialog box.

The dialog box cannot be saved if these boxes are left empty.

Enterprise Networking
If Enterprise Networking is installed, you must provide a placeholder for the
Enterprise site ID. You replace this placeholder with the actual site ID when
implementing Enterprise Networking.

If you know the Enterprise site ID, enter it during configuration.

VPIM Networking
If VPIM Networking is installed, you must provide a placeholder for the SMT
VPIM Networking server FQDN. You replace this placeholder with the actu
server FQDN when implementing VPIM Networking.

If you know the server FQDN, enter it during configuration.

Name
The messaging server is usually given a name that corresponds to its geog
location. The name given to the messaging server becomes the name of th
NMS network.

By default, both the Meridian Application Server and the prime switch locat
are assigned the name “Untitled.” You assign a new name to the server an
prime switch location during configuration.

Server type
The local server is always CallPilot.

Description
A brief description of the Meridian Application Server or implementation not
such as when the messaging server was configured or who completed the 
configuration, may be useful here.
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Remaining boxes
All other boxes on the General tab are configured only if a CallPilot network
solution is implemented. These boxes are completed during the implement
of that solution’s messaging server.

Enterprise Networking and VPIM Networking
Enter required placeholders if Enterprise Networking, VPIM Networking, or 
both, are installed on the messaging server. If Enterprise Networking is insta
you require an Enterprise Site ID. If VPIM Networking is installed, you requ
a Server FQDN.

If known, enter the required information.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration
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To configure the local messaging server

1 In the Messaging Network Configuration tree view, select the local 
messaging server.

2 On the File menu, click Open.

Result: The Local Prime Server Properties—General tab appears.

3 To change the name of the local messaging server, enter a new name in 
the Name box.

Tip: The name given to the messaging server is also the name of the NMS 
network.

Note: The server type is always CallPilot and cannot be changed.

4 In the Description box, enter details about the local messaging server.

5 Click Save.

Result: The information is validated and saved to the network database.
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What’s next?
After configuring the local messaging server, configure the local prime switc
location.
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Configuring the switch locations

In this section
About configuring the local prime switch location 138

Configuring the ESN information 144

Configuring the CDP information 147

Adding and configuring a satellite switch location 150

Recording a spoken name 153

Importing a spoken name 155
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About configuring the local prime switch 
location

Introduction
When NMS is initially installed on the Meridian Application Server, a local 
messaging server and a local switch location are automatically added to the
Messaging Network Configuration tree view.

Configure the local prime switch location to implement NMS.

Prime Switch Location Properties dialog box
The local prime switch location is configured on the Prime Switch Location 
Properties dialog box, which has four tabs:

■ General

■ ESN

■ CDP

■ SMTP/VPIM
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General tab
Complete the General tab regardless of which dialing plan your site uses.

ESN tab
Complete the ESN tab if the local site uses the ESN or a hybrid dialing plan

CDP tab
Complete the CDP tab if the local site uses the CDP or a hybrid dialing plan

SMTP/VPIM tab
The SMTP/VPIM tab is enabled only if VPIM Networking is installed on you
local switch location. The SMTP/VPIM tab is completed during the 
implementation of VPIM Networking.

. 
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Name
Each switch location must be assigned a name that is unique in the NMS 
network. 

Usually, the name assigned to the prime switch location corresponds to the 
of the messaging server. This ensures that the identity of the switch locatio
within the network is immediately apparent. A geographic name is common

For example, if a messaging server is named “Moscow,” the prime switch 
location is usually also named “Moscow.”

By default, the local prime switch location is given the name “Untitled.” This
name must be changed.

Description
This box is useful for short notes, reminders, or comments about the switch
location.

You may find it useful to specify your switch model, the date of the switch 
configuration, or contact information for the switch technician.

Enterprise Location ID
The Enterprise location ID of the prime switch location is set to 0 by default 
cannot be changed.

Spoken Name Recorded
The Spoken Name Recorded check box is enabled if NMS is installed. 

When a user on a satellite switch location composes and sends a message
user on the prime switch location, or uses the Play feature to hear who sen
message, the user hears the spoken name. This can be useful as a confirm
especially when several switch locations use the same mailbox number.

If a spoken name is not recorded, local users hear the full address, such as
“Mailbox 64441234.” If a recording is available, local users hear the switch 
location name followed by the mailbox number.

You can either record a message using the telephone or import a prerecord
WAV file.
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If you do not want your local users to hear the name of this switch location w
composing messages or using playback, do not record a message. For exa
if you are using the CDP dialing plan and users dial in the same way as they
messages, you may feel that a spoken name is unnecessary.

Dialing plans for dialing to this location
When configuring the local prime switch location, you are specifying the dial
plan that is used to dial to the local site. 

You must specify the dialing plan used to dial to the local switch location:

■ ESN

■ CDP

■ hybrid, combining ESN and CDP

If ESN is used anywhere in the messaging network, ESN must be selected
because an ESN access code is required.

Mailbox addressing follows dialing plan
This box is dynamically enabled and disabled depending on the dialing plan
specified.

A mailbox is often the same as the number used to dial a user, but this is n
requirement. For example, Joan Chen’s mailbox number is 7575, but her 
extension number is 8888.

You must specify if, at your local site, the mailbox number is the name as th
number dialed.

In most cases, the mailbox follows the dialing plan, and a mailbox prefix is 
required.

However, if the mailbox does not follow the dialing plan, you must specify a
least one mailbox prefix. The mailbox prefix identifies the location of the 
mailbox.

ATTENTION! It is strongly recommended that the mailbox follow the 
dialing plan. If the mailbox does not follow the dialing 
plan, some features, such as Call Sender, will not work
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Mailbox prefixes
This box is dynamically enabled and disabled depending on the dialing plan
specified.

A mailbox prefix is a leading string of digits that uniquely identifies a mailbo
number as belonging to a particular site. A mailbox prefix is required only if 
mailbox does not follow the dialing plan, that is, if users address a message
differently than they dial.

The mailbox prefix is similar to an ESN location code or a CDP steering cod
However, the mailbox prefix does not reflect a dialing plan. Instead, the pre
identifies a switch location in an NMS network.

If the local site has NMS installed, the mailbox prefix or prefixes must be 
configured. 

Note: Two mailbox prefixes provide flexibility of addressing.

If a spoken name is not recorded, users hear the mailbox prefix combined w
the mailbox number.

Example
A switch location, Toronto, has the following mailbox prefixes:

■ 83

■ 1214597

Users can address to Toronto mailbox 1234 by entering 83 1234 or 121459
1234.

Mailbox prefixes cannot conflict with other prefixes, such as the VPIM comp
prefix and the AMIS compose prefix. Avoiding conflict may mean inserting 
leading digits—for example, 81214597.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To configure the Prime Switch Location Properties dialog box

1 In the Messaging Network Configuration tree view, select the local prime 
switch location.

2 On the File menu, click Open.

Result: The Messaging Network Configuration—Prime Switch Location 
Properties—General tab appears.

3 To change the name of the local prime switch location, enter a name in the 
Name box.

4 In the Description box, enter details about the local prime switch location.

Note: The location ID is always 0 and cannot be changed.

5 To include recorded a spoken name, either

■ Click Record to record a message, or

■ Click Import to import a prerecorded message.

Note: For detailed instructions on how to record a spoken name, consult 
Sharing the configuration information on page 158. For detailed instructions 
on how to import a prerecorded spoken name, consult Importing a spoken 
name on page 155.

6 Specify the dialing plan used to dial the local prime switch location. Select 
the

■ ESN check box if ESN is used

■ CDP check box if CDP is used

■ ESN and CDP check boxes if a hybrid dialing plan is used

7 If users address messages in the same way that they dial, select the 
Mailbox addressing follows dialing plan box.

8 If users do not address messages in the same way that they dial, enter at 
least one mailbox prefix.

9 Select the tab you must complete next to continue the configuration.
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Configuring the ESN information

Introduction
If the local prime switch location uses either an ESN dialing plan or a hybrid
dialing plan, you must complete the ESN tab.

You must provide the ESN access codes and ESN location codes. These a
combined to create the ESN prefix.

See also
For a general description of the ESN dialing plan and how it works, consult
Networking Planning Guide.

. 
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ESN Access Code used by this location
The ESN access code is used to access ESN routing in the same way that
access code, such as 9, is used to call out to the public network from a priv
network.

Typically, all switches in a messaging network use the same ESN access c

ESN Location Codes
An ESN location code is a routing prefix that identifies a location within a 
network. It is usually three digits long, but can be up to ten digits long.

You must also indicate the number of digits in the ESN location code that 
overlap with the mailbox number.

The ESN Location Codes list contains all ESN location codes currently assig
to the NMS network. The list also indicates the overlap between the ESN 
location code and the mailbox directory numbers.

ESN location codes can be added, modified, or deleted at any time. Howev
overlaps are defined, then deletion may affect the remote user entries defin

ESN location code capacity
The maximum number of ESN location codes for a switch location is 30.

ESN location code overlap
The ESN location code overlap is the number of digits shared by the locatio
code and an extension number.

If there is overlap between the rightmost digit or digits of the location code a
the leftmost digit or digits of the extension number, enter the amount of ove

The following table gives two examples of ESN location code overlap:

Access 
code

Location 
code

Extension 
number

Number dialed by users at 
other sites Overlap

6 338 83000 633883000 0

6 338 83000 63383000 1
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To configure the ESN information

1 Open the Prime Switch Location Properties—ESN tab.

2 Enter the ESN access code.

3 To add a new location code, click the Add New button.

Result: The New ESN Location Code Properties dialog box appears.

4 In the Location Code box, enter the location code.

5 In the Overlap box, enter the number of digits in the extension number that 
overlap the location code.

6 Click Save.

Result: The location code and overlap are validated and appear in the ESN 
Location Codes list box on the ESN tab.

7 Repeat steps 3–6 for each ESN location code required.

8 When you have finished configuring the ESN information, determine if you 
must configure CDP information. 

■ If yes, click the CDP tab. 

■ If no, click Save to validate the ESN configuration and save it to the 
database.
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Configuring the CDP information

Introduction
If the local switch location uses either a CDP dialing plan or a hybrid dialing
plan, complete the CDP tab.

You must provide the CDP steering codes.

See also
For a general description of the CDP dialing plan and how it works, consult
Networking Planning Guide.

. 
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CDP Steering Codes
A CDP steering code is a site prefix that identifies the site and location with
the network. Therefore, a CDP prefix must be unique for all switches in the
messaging network.

The CDP steering codes must still be defined here, because the system mu
able to identify the steering code in the mailbox number to determine the si
and location.

The CDP Steering Codes list box contains all CDP steering codes currently
assigned to the switch location. The list also indicates the overlap between
CDP steering code and the mailbox directory numbers.

CDP steering codes can be added, modified, or deleted.

CDP steering code capacity
The maximum number of CDP steering codes for a switch location is 500.

CDP steering code overlap
The CDP steering code overlap is the number of digits shared by the steeri
code and an extension number.

If there is overlap between the last digit or digits of the steering code and th
first digit or digits of the extension number, enter the amount of overlap.

The steering code often overlaps with the first few digits of a local extension
number. A full overlap, in which every digit of the steering code overlaps th
extension, is typical.

The following table gives three examples of CDP steering code overlap:

Steering 
code

Extension 
number

Number dialed by users at 
other sites Overlap

22 22345 2222345 0

22 22345 222345 1

22 22345 22345 2
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

. 

To configure the CDP information

1 Open the Prime Switch Location Properties—CDP tab.

2 Click the Add New button.

Result: The New CDP Steering Code Properties dialog box appears.

3 In the Steering Code box, enter the steering code.

4 In the Overlap box, enter the number of digits in the extension number that 
overlap the steering code.

5 Click Save.

Result: The steering code and overlap are validated and appear in the 
CDP Steering Codes list box on the CDP tab.

6 Repeat steps 2–5 for each CDP steering code required.

7 When you have added all necessary CDP steering codes, click Save.

Result: The information is validated and saved to the network database.

What’s next?
You have completed the configuration of the prime switch location and are 
ready to begin adding and configuring satellite switch locations.
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Adding and configuring a satellite switch 
location

Introduction
You must add and configure each satellite switch location in the NMS netw

The process of configuring a satellite switch location is almost identical to th
process of configuring the prime switch location.

Satellite Switch Location Properties dialog box
A satellite switch location is configured on the Satellite Switch Location 
Properties dialog box. This dialog box consists of four tabs:

■ General

■ ESN

■ CDP

■ SMTP/VPIM
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General tab
You must complete the General tab regardless of which dialing plan your si
uses.

ESN tab
Complete the ESN tab if the local site uses the ESN or a hybrid dialing plan

CDP tab
Complete the CDP tab if the local site uses the CDP or a hybrid dialing plan

SMTP/VPIM tab
The SMTP/VPIM tab is enabled only if VPIM Networking is installed on you
local switch location. The SMTP/VPIM tab is completed during the 
implementation of VPIM Networking.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To configure a satellite switch location

1 In the Messaging Network Configuration tree view, select the local 
messaging server.

2 On the File menu, select New > Switch location.

Result: The Satellite Switch Location Properties dialog box appears.

3 In the Satellite Switch Location Properties dialog box, complete the General 
tab.

Note: For instructions on how to record a spoken name, consult Sharing 
the configuration information on page 158. For instructions on how to 
import a spoken name, consult Importing a spoken name on page 155.

4 Complete the ESN tab and the CDP tab as required.

5 Click Save.

Result: The information is validated, and the satellite switch location is 
added to the remote site.

6 Repeat steps 1–5 for each satellite switch location required.

7 When all satellite switch locations are added, on the Messaging Network 
Configuration tree view, click Save to add the configured satellite switch 
locations to the network database.

What’s next?
If your NMS network is an NMS site within a larger messaging network, you
must share the configuration details with all other network administrators.
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Recording a spoken name

Introduction
You can create a recording of the name of a switch location. A recorded nam
heard by a local user whenever an address is played back. A recorded nam
site is played if a user does not have a personal recorded name.

Local switch location
If your local site is not an NMS site, a spoken name is not required for the l
site.

If your local site is an NMS site, you can decide if you want to record a spo
name. For example, if the NMS site uses CDP, you may decide a spoken na
not necessary.

Remote switch location
A spoken name should be available for every remote site in your Message 
Delivery Configuration tree view.

The recording is played when local users compose messages to the remote

Importing a spoken name
If you do not want to record your own voice using the telephone, you can im
a prerecorded WAV file. See Importing a spoken name on page 155.

Before you begin
You need a telephone as a microphone.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To record a spoken name

1 In the Messaging Network Configuration tree view, select the switch 
location of the site for which you want to record a spoken name.

2 On the File menu, select Open.

Result: The Switch Location Properties dialog box appears.

3 On the General tab, click Record.

Result: The Specify Phoneset dialog box appears.

4 Enter the telephone number of the telephone to be used as a microphone, 
and click Dial.

Result: The telephone rings and the Voice Recorder dialog box appears.

5 Answer the telephone.

6 In the Voice Recorder dialog box, click Record.

7 Speak the name of the site into the telephone.

8 Click Stop.

9 To review the recording, click Play.

10 If you are satisfied with the recording, click Done.
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Importing a spoken name

Introduction
You can import a prerecorded file of the name of a switch location. The 
recording is heard by a local user whenever an address is played back. A 
recording for a site is played if a user does not have a personal spoken nam

Local switch location
If your local site is not an NMS site, a spoken name is not required for the l
site.

If your local site is an NMS site, you can decide if you want to import a spok
name. For example, if the NMS site uses CDP, you may decide a spoken na
not necessary.

Remote switch location
A spoken name should be available for every remote site in your Message 
Delivery Configuration tree view.

The recording is played when local users compose messages to the remote

Instead of importing a spoken name
If you do not want to import a prerecorded spoken name, you can record yo
own voice message using the telephone.

Before you begin
A prerecorded WAV file must be available. Check the quality of the recordin
before importing the file.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To import a prerecorded file

1 In the Messaging Network Configuration tree view, select the switch 
location of the site for which you want to import a prerecorded file.

2 On the File menu, select Open.

Result: The Switch Location Properties dialog box appears.

3 On the General tab, click Import.

Result: The Open dialog box appears.

4 Select the WAV file, and click Open.

Result: The file is imported.

5 Close the Open dialog box.
156 CallPilot



November 1998 Configuring CallPilot for NMS 
Additional administrative tasks

In this section
Sharing the configuration information 158

Adding local users 159
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Sharing the configuration information

Introduction
If your NMS network is an NMS site within a larger messaging network, you
must share the details of your configuration with the network administrators
all sites with which your site exchanges messages.

These remote network administrators add your NMS site to their network 
databases.

How to share configuration information
The easiest way to share the configuration information is to print the conten
Properties dialog boxes and to distribute the printouts to all network 
administrators.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To print a Properties dialog box

1 From the Messaging Network Configuration tree view, open the Properties 
dialog box that you want to print.

2 Click Print.

Result: The contents of the selected Properties dialog box are printed. The 
printout includes the contents of all tabs.
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Adding local users

Introduction
All users in an NMS network must be added to the Meridian Application Ser
as local users.

Users on the prime switch location
Users on the prime switch location are added as local users.

Users on the satellite switch locations
Users on the satellite switch locations are also added as local users. Howe
during the configuration of these users, the location must be specified from
drop-down list on the New User Properties dialog box—Mailbox tab.
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Getting there  Nortel SMI > Meridian Application Server > User Administration > 
User Creation Templates

To add a new satellite switch location user

1 In the New User Properties dialog box, select the type of template to be 
used.

Result: The template opens.

2 Complete all information that is required to create any user.

3 On the Mailbox tab, in the Location name drop-down list, select satellite.

4 Enter the name assigned to the satellite switch location in the Location 
name box.

5 When all required information is complete, click Save.

See also
For detailed instructions on how to add local users, consult the relevant sec
in the Basic Administration Guide.
160 CallPilot



The 
e 

re that 
c h a p t e r  6

Testing and backing up NMS

This chapter describes how to test the configuration of your NMS network. 
test suite ensures that NMS is working properly both locally and with remot
sites.

This chapter also describes how to create a backup of your system to ensu
the configuration is not lost due to system failure.

In this chapter 
Tests and backups 163
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Tests and backups

In this section
Overview 164

Testing the NMS network 165

Backups 167
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Overview

Introduction
After configuring CallPilot for NMS, test the system to ensure that it is worki
properly.

The NMS test suite determines if the NMS network is properly configured an
the switch locations can exchange messages.

Perform the tests in the sequence presented. If any test in the suite fails, re
the problem before continuing with the tests.

When to test the system
The NMS network should be tested

■ after the initial setup and configuration of the NMS network

■ after any subsequent changes are made to the configuration

■ as part of the regular maintenance

Before you begin
To run the tests, add some users to each switch location for the purpose of
testing. 

Enable the Auto-Login feature for some of the mailboxes so that this feature
be tested.

See also
For instructions on how to add users, consult the relevant section in the Basic 
Administration Guide.

For instructions on how to enable the Auto-Login feature, consult the Basic 
Administration Guide.
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Testing the NMS network

Introduction
After CallPilot is configured for NMS, the system must be tested.

The tests must be performed to ensure that the configuration is correct. If a t
not successful, resolve the problem and retry the test before continuing.

DN test
The DN test determines that DNs are properly configured.

To perform the DN test
From a telephone on any switch in the network:

Dial each of the Voice Messaging DNs on every switch in the network. Use the 
full ESN or CDP number of the Voice Messaging service.

The test is successful if you reach the Voice Messaging service for each sw

Auto-login test
The auto-login test determines if the Auto-Login feature, if enabled, is availa
to users on all switch locations in the NMS network.

To perform the auto-login test
From a telephone that has the Auto-Login feature enabled:

1 Attempt auto-login by dialing the Voice Messaging service for the switch.

2 Repeat the test from a telephone with Auto-Login enabled on each switch.

The test is successful if you are logged in automatically and are not prompte
a mailbox number and password.
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Thru-dial test
The thru-dial test determines if users are able to use the Thru-Dial feature am
switches in the NMS network.

To perform the thru-dial test
From a telephone on a switch:

1 Log on to CallPilot.

2 Try to thru-dial an extension on another switch in the NMS network.

3 Repeat this test from a telephone on every switch in the network.

The test is successful if you are able to thru-dial to that extension.

Features test
The features test determines if CallPilot features, such as Message Waiting
Indicator (MWI) and Call Sender, are available throughout the NMS networ

To perform the features test
From a telephone on a switch:

1 Compose and send a message to several mailboxes at each switch.

2 Confirm that the MWI lights are activated on all receiving telephones.

3 Call in to each mailbox, access each message, and use the Call Sender 
feature.

4 Repeat from a telephone on every switch in the NMS network. Address by 
all ESN, CDP, and local extension combinations.

The test is successful if you are able to send messages and the received me
offer full features.

What’s next?
After successfully completing the NMS test suite, perform a backup of your
system.
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Backups

Introduction
When all tests of the system are successfully completed and NMS is workin
properly, perform a backup.

The backup ensures that the configuration is not lost in the event of a syste
failure.

Backup schedule
Perform backups as part of the implementation process and as part of regu
maintenance activities.

Implementation backup
Perform a manual backup as the final step in the NMS implementation proc
This backup is needed even if the system is configured to perform an autom
backup.

In the unlikely event that the system experiences a disk failure before the 
automatic backup takes place, the network configuration could be lost.

Maintenance backup
Perform a backup whenever the NMS configuration information is modified
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System backup components
A system backup consists of two parts:

■ a switch backup

■ a CallPilot backup

Switch backup
For detailed instructions on how to perform a switch backup, consult your 
switch documentation.

CallPilot backup
You can perform a full or partial backup of your CallPilot server.

For detailed instructions on performing a CallPilot backup, consult the relev
section in the Basic Administration Guide.
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Maintaining NMS

After you complete the NMS implementation process, you only need to perf
regular maintenance.

This chapter describes maintenance procedures that must be performed 
regularly. The chapter also describes maintenance procedures that you per
only when required.

In this chapter
About maintaining NMS 171

Regularly scheduled maintenance tasks 177

As-required maintenance tasks 181
NMS Implementation and Administration Guide 169
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About maintaining NMS

In this section
Overview 172

Network history 174

Printing configuration information 175
NMS Implementation and Administration Guide 171
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Overview

Introduction
After you successfully implement and test NMS, the system only requires 
maintenance.

There are two types of maintenance tasks:

■ regularly scheduled tasks

■ as-required tasks

Regularly scheduled tasks
Regularly scheduled tasks include

■ checking the network status

■ reviewing Operational Measurement (OM) reports

Although you can perform regularly scheduled tasks at any time, perform th
tasks at least once a week. Because these tasks do not interfere with the 
operation of NMS, you can schedule them at a convenient time during a reg
workday.

If you monitor the performance of your messaging network, you avoid futur
problems. Careful monitoring shows bottlenecks in the system and indicate
how the system can be improved.

Monitoring can also help you to plan and forecast future messaging networ
requirements.

As-required tasks
Perform as-required tasks as needs arise. As-required tasks include

■ modifying networking parameters

■ disabling and enabling NMS

■ modifications to the NMS configuration
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When to perform as-required tasks
Since as-required tasks may affect the entire system, perform these tasks w
the system is not in heavy use.

Modifications to the configuration may be necessary for the following reaso

■ New legal delivery times are announced for computer-generated calls.

■ The system performance suggests that adjustments to the parameters
required.

■ The system access number is changed.

Note: There is no way to temporarily disable an NMS network.

Perform a backup following maintenance
Perform a backup of the system whenever you modify the network parame
as part of your maintenance.

ATTENTION! Because as-required tasks may affect the performance
the entire system, schedule them for off-peak hours.
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Network history

Introduction
Keep detailed records of your network’s history. These records can

■ Indicate significant performance or equipment issues that real-time 
monitoring may not detect.

■ Provide a background for comparing the current information.

■ Contain information needed during support calls.

Information to record
A network history should include the following types of information:

■ installation dates and descriptions

■ contact information for all key personnel involved in the system installat
and configuration

■ details of software installed on the messaging server, including version

■ installation process and results, including tests

■ diagrams of the initial and subsequent network configurations

■ any problems encountered and their solutions

■ hardware and software changes

■ changes to the messaging network layout

Where to keep the records
Make the records of your messaging network easy to access and read. Gra
including hand-drawn sketches, can be very useful.

Keep records in a log or online. Note, however, that online  records cannot 
accessed if the system crashes.

See also
For a detailed description of messaging network histories, consult the 
Networking Planning Guide.
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Printing configuration information

Introduction
Printouts of the system configuration are often included in a network history
You can print all configuration information contained in your local network 
database.

To print configuration information, you must open the relevant Properties dia
box. For example, to print an item in the Messaging Network Configuration 
view, you must open the Properties dialog box of the item.

If a Properties dialog box consists of more than one tab, the contents of all 
are printed.

Note: You cannot print the tree view of the messaging network contained in
Messaging Network Configuration dialog box.

When to print configuration information
Although configuration information is always available in the most recent 
backup of your network database, you may find it convenient to make printo
as well.

Printouts of the configuration information are especially useful in the followi
situations:

■ You must fax information to a remote network administrator.

■ You are keeping a network history.

■ You are planning to change a configuration or delete an item from the 
Messaging Network Configuration tree view, and you want a hard copy
the original configuration.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration or Messaging 
Network Configuration

To print configuration information

1 Open the dialog box that you want to print.

2 With the dialog box open, click the Print button.

Result: The contents of the dialog box print. The printout includes the 
contents of all tabs.
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Regularly scheduled maintenance tasks

In this section
Reviewing OM reports and alerts 178
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Reviewing OM reports and alerts

Introduction
Operational Measurement (OM) reports and alerts provide detailed informa
on the status and performance of NMS.

No reports specifically provide NMS information because, to CallPilot, users
the satellite switches are local users.

However, the reports that provide information specific to each switch locatio
are useful for determining the system’s performance.

Primary reports
The following reports provide useful information:

■ System Traffic

■ Channel Usage

■ Disk Usage Monitor

■ MMFS Usage Monitor

■ Service Quality Detail

■ Service Quality Summary

Additional reports
Statistics for each switch location are also provided in reports that are assoc
with individual users or where users can be used as a filtering or grouping 
criteria, even though the switch location is not displayed.

These reports are

■ 800 Access Bill-back

■ Messaging Usage Bill-back

■ Network User Bill-back

■ RN Usage Bill-back

■ DTT Usage Bill-back

■ Call Answering/User Reponsiveness (filter only)
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■ Mailbox Counts (group only)

■ Messaging Usage (filter only)

■ Users Exceeding Storage Limit

■ Top Users of Storage

Although you can review OM reports at any time, you should review them a
least weekly.

Access to OM reports is restricted
The generation of OM reports is a restricted activity that is  determined by 
access level. If you do not have the necessary access, you must ask your s
administrator to generate the reports.

The OM report request screens let you choose the reports that you want to
and print. For many reports, you can also customize the displayed results s
you receive the information in a format that best suits your needs.

See also
For additional information on OM reports, including how to generate and 
interpret them, consult the Reporter Guide.
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As-required maintenance tasks

In this section
Modify the local messaging server 182

Modify the prime switch location 183

Adding, modifying, and deleting satellite switch locations 185
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Modify the local messaging server

Introduction
It is unlikely that you will have to modify the configuration of the local 
messaging server. However, if necessary, it can be modified.

NMS network
The configuration of the local messaging server to implement an NMS netw
is simple. This configuration requires the name assigned to the messaging s
and a description. These can be changed easily and will not affect any othe
aspect of the system.

NMS site
If the local NMS network is part of a larger messaging network—that is, it is
NMS site—modifications to the local messaging server are more complicat

For detailed instructions on modifying the local messaging server, consult t
appropriate implementation and administration guides.
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Modify the prime switch location

Introduction
You can modify the configuration of the prime switch location.

NMS network modifications
You can change the configuration of your prime switch location.

Common modifications include changes to the spoken name recorded, to E
prefixes, and to CDP steering codes.

Uncommon modifications, such as changes to the dialing plan, should be m
only when absolutely necessary.

To make any modifications to the prime switch location, use the process 
described for the original implementation.

CAUTION!
. 

Risk of loss of functionality
Changes to the networking configuration should be done duri
hours when users are not logged on. Making changes to the 
configuration while users are logged on may result in loss of 
messaging functionality.
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NMS site modifications
If your NMS network is a site within a larger network, any additions, 
modifications, or deletions that you make affect the entire network.

To ensure the continued integrity of the network, follow these steps:

1. Make all required changes.

2. Perform the NMS networking suite of tests to ensure that the changes 
acceptable.

3. Perform all necessary networking solution test suites.

4. Perform a backup of your system.

5. Inform the system administrators of all other sites on the network of the
changes that you have made.

6. Ask the system administrators to change their Messaging Network 
Configuration entries to reflect your changes.
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Adding, modifying, and deleting satellite 
switch locations

Introduction
If your NMS network is a site within a larger network, any modifications tha
you make affect the entire network. 

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

Adding a satellite switch location
To add a new satellite switch location to the NMS network, follow the 
instructions described in “Adding and configuring a satellite switch location”
page 150.

Note: If the NMS network is a site in a larger network, deleting a satellite swi
location at your location will affect the configuration of all other sites in the 
network with which you exchange messages. You must contact the 
administrators of all other sites and ask them to add the satellite switch loca
from their Messaging Network Configuration tree views also.

CAUTION!
. 

Risk of loss of functionality
Changes to the networking configuration should be done duri
hours when users are not logged on. Making changes to the 
configuration while users are logged on may result in loss of 
messaging functionality.
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To modify a satellite switch location configuration

1 In the Messaging Network Configuration tree view, highlight the satellite 
switch that you want to modify.

2 On the File menu, select Properties. 

Result: The Satellite Switch Location Properties dialog box for the selected 
switch appears.

3 Make all required changes to the tabs, and click Save.

4 Test and back up the system.

Note: If your NMS network is a site in a larger network, any modifications th
you make to your switch setting will affect the entire network. Inform remote
network administrators of all changes.

Deleting a satellite switch location
When a satellite switch location is no longer required in an NMS network, it
must be removed from the Messaging Network Configuration tree view.

To delete a satellite switch location

1 In the Messaging Network Configuration tree view, highlight the satellite 
switch that you want to delete.

2 On the File menu, select Delete.

3 Press Save. 

Result: The deleted satellite location no longer appears in the Messaging 
Network Configuration tree view.
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Troubleshooting NMS

Although testing and regular maintenance ensure that your NMS site is wor
properly, the system may experience occasional problems.

This chapter describes how to diagnose and correct these problems.

In this chapter
Overview 189

Problem: User unable to log in to mailbox 191
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Overview

Introduction
If you are experiencing problems with NMS, this chapter will help you to 
identify and solve these problems.

Common causes of NMS problems include the following:

■ Networking information is incorrect or incomplete.

■ The switch is configured incorrectly.

Identifying the source of the problem
To identify the source of the NMS problem, first determine if NMS is disable

Note: You cannot temporarily disable NMS on the Meridian Application Serv
NMS is disabled on the switch. To determine if NMS is disabled, check the
restrictions on the switch.

If NMS is not disabled, then review the following:

■ appropriate Alarm and Event reports

■ network status

■ Operational Measurement (OM) reports
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Switch-related problems
If you are unable to identify the problem using CallPilot, the problem may b
switch-related. Perform the call trace test to determine if there is a problem 
the switch configuration.

Call trace
Call trace helps you to determine if network calls are being blocked for one
more of the following reasons:

■ Digit manipulation is performed incorrectly. Either not enough or too ma
digits are inserted or deleted.

■ Class of service restrictions are either too stringent or too loose.

■ Dialing is incorrect. More digits are required by the trunks or trunk route

Note: You can perform a call trace on a telephone or on a trunk and a trunk
route.

Hardware problems
If you are unable to locate the problem in the CallPilot configuration or in th
switch, your system may be experiencing hardware problems that are not re
to networking.

Perform a basic hardware check. Examine all connections.
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Problem: User unable to log in to mailbox

Introduction
When a user on a satellite switch phones the voice only messaging DN on 
satellite switch, the user should be able to enter the mailbox with only a mai
number and a password. No prefix should be necessary.

If a user is unable to log in properly, you must determine the cause of the 
problem.

Diagnostic
There are two likely causes for the problem:

■ The switch is incorrectly configured.

● The DNs are incorrect.

■ CallPilot is incorrectly configured.

● The SDN Table is incorrect or incomplete.

Note: If the system worked before but is not currently working, check if the u
login is disabled. 

Solution
If you determine that the problem is not switch-related, check the configura
of the SDN Table.

There must be entries in the SDN Table for all services provided by the sat
switch location.

If a CDP dialing plan is used, ensure that the SDN is in a format that is dial
from the prime switch location.

If an ESN dialing plan is used, ensure that the SDN is in a format that is dial
from the prime, but do not include the ESN access code.
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Other necessary actions
After making changes to the SDN table, complete the NMS test suite. If the
problem is corrected, perform a partial backup of the system.

Contact technical support
If you are unable to correct the problem and must contact technical support,
the following information available:

■ network history

■ error messages

■ network representation with dialing plan information
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